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Course Overview
Course Description

We are all amazed at computer generated imagery. MicroStation V8i and its new 
Luxology rendering engine provide you with powerful new rendering tools and 
possibilities.

The MicroStation V8i for Rendering course requires knowledge of MicroStation 
3D. While it is intended for users that are beginners, through intermediate, in 
Aug-12 7 Course Overview
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Course Description
rendering, it covers many advanced topics as well. Even an expert could learn 
many valuable tips and tricks to improve their renderings.

This course covers Rendering only and does not cover Animation which is a 
separate course.

This course assumes you know nothing about rendering. You will find it starts out 
slowly, covering the important basics, and then progresses to more advanced 
topics. The course is laid out in order of importance, beginning with three basic 
requirements for rendering, Cameras, Lights, and Materials. Of course, there is 
the need for a good 3D model too, but this course does not cover 3D modeling.

If you cannot master MicroStation's camera tools you will have great difficulty 
taking that all important picture of your finished project. This topic is covered in 
detail.

A great deal of time also is devoted to lighting, which comes in second on the list 
but may, in fact, be the single most important aspect of the rendering process. 
You should be able to make a 3D scene look good even if all your materials 
happen to be cardboard. 

Setting up the right lighting can make or break a rendering so quite a bit of time is 
devoted to the subject of lighting.
Course Overview 8 Aug-12
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Course Description
For truly photo-realistic results you will learn to master MicroStation's material 
editor and how to attach and apply these materials to a variety of 3D models 
including civil, architectural and industrial design.

Navigating through a myriad of rendering dialog boxes and settings you will learn 
what these settings are and how they affect each rendering mode. Through 
exercises you will be able to see the affects a setting can have on your renderings. 
You will learn specialized procedures, such as using ArchVision® RPC™ files to add 
realpeople™ and realtrees™ to your 3D scenes. You will learn also, how to plot 3D 
content to Adobe® PDF and to navigate a PDF, containing 3D content, using 
Adobe® Reader® 9.0.

You will also learn how to use multiple computers across a network to render a 
single high resolution image in a fraction of the time normally required. You will 
Aug-12 9 Course Overview
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Target Audience
learn all about generating image output from still images to panorama virtual 
reality images and image objects.

Included with the book is a dataset with a workspace containing all the models, 
and materials, used in the course. Bonus materials in the dataset include a library 
of textures, skies, environments and bump maps. Also included are several 
sample RPC content files provided courtesy of ArchVision, Inc.

Target Audience

This course is recommended for the following audience(s):

• Architects

• Engineers

• Designers

• Visualization Specialists

Prerequisites
• Expert knowledge of AccuDraw 2D and 3D

• Ability to construct 3D models

• Ability to use the 3D view navigation tools

• Experimented with Rendering tools

Course Objectives

After completing this course, you will be able to:

• Create images from the MicroStation rendering system

• Control LIghts, Cameras and Materials

• Apply advanced techniques to improve image quality and emphasize 
important graphics
Course Overview 10 Aug-12
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Modules Included
Modules Included

The following modules are included in this course:

• Introduction to Rendering

• Luxology Rendering Settings

• Cameras

• Lights

• Basic Materials

• Advanced Materials

• Output of Imagery

• Final Project
Aug-12 11 Course Overview
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Modules Included
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Introduction to Visualization
Module Overview

MicroStation V8i for Rendering course requires a prerequisite knowledge of 
MicroStation 3D. While it is intended for users that are beginners, through to 
intermediate, in rendering, it covers many advanced topics also. Even an expert 
could learn many valuable tips and tricks to improve his or her renderings.
Aug-12 13 Introduction to Visualization
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Module Prerequisites
This course assumes you know nothing about rendering. The course is laid out 
with a workflow in mind beginning with Cameras, Lights, and Materials. Of 
course, there is the need for a good 3D model too, but this course does not cover 
3D modeling, though you can certainly find a large number of fine models from 
Utilities > 3D Warehouse.

Module Prerequisites
• Expert knowledge of AccuDraw in 2D and 3D

• Basic knowledge of 3D tools and View Controls

• Knowledge of MicroStation Tasks and Tools

Module Objectives

After completing this module, you will be able to:

• Use the Visualization task

• Find all the Rendering tools

• Prepare for cameras, lights and materials

• Learn how to stage a shot

Things to Remember

As with any MicroStation course remember to:

1 Pick the tool

2 Adjust your settings

3 Read the prompt

Even though this is an advanced course, these rules still apply.

AccuDraw is critical to proper placement and usage of lights and cameras. Review 
your AccuDraw 3D shortcuts and usage.
Introduction to Visualization 14 Aug-12
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Operating Systems and Hardware
Rendering is an computationally intense application. It requires good models, 
computers and efficient visualization techniques in order to be cost-effective in 
production. Lets look at Computers and Models now and discuss the techniques 
throughout the course.

Operating Systems and Hardware

Few things will slow your computer down as much as rendering. In order to take 
full advantage of the software it is critical that you match it up with good 
hardware.

A recommended web site for hardware is:

http://www.tomshardware.com

Operating Systems

MicroStation and Luxology support both 32-bit and 64-bit Windows operating 
systems. In order to take full advantage of your hardware resources it is 
recommended that you use Windows 64-bit operating systems.

OS

Windows XP Professional 64-bit

Windows Vista Business/Ultimate 64-bit

Windows 7 64-bit

Hardware

There are many choices available for hardware. You can consult:

http://communities.bentley.com/Wiki/view.aspx/
MicroStation_V8i_System_Requirements_and_Hardware_Recommendations

for the latest updates.
Aug-12 15 Introduction to Visualization
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Operating Systems and Hardware
CPU

The recommended CPU (November 2009) for heavy visualization usage is:

• Dual Quad-Core Intel® Xeon® Processor X5492

• 3.33 GHz, 12MB L2 cache, 1600 MHz front side bus

• Dual Core i7 975

• 3.33 GHz, 8MB L3 cache, 3200 MHz front size bus

• Dual Six-Core AMD Opteron 2439 Processor 

• 2.8 GHz, 3 MB L2 cache, 4.8 GHz System bus

Memory

12 GB - More can be utilized by Luxology Rendering engine on 64-bit OS’es. Check 
your motherboard specifications for capacity and timing compatibility.

Hard Drives

It is best to use a RAID controller to control your drives. Since the Hard Drive is the 
slowest part of your computing environment it is best to invest in good drives.

The recommended configuration is:

• RAID controller

• 15,000 rpm drives

• Serial-attached SCSI drive - SAS Drives

• Examples: Seagate Cheetah, Hitachi Ultrastar

Alternately, you can go with SATA, 10,000 rpm drives, which are larger in capacity 
than SAS drives. Flash drives are getting larger but are still too small and may not 
have enough life expectancy for such intense computing.

Video Cards

Contrary to popular belief the video card is not the most important piece of the 
hardware setup. CPU and Memory are the most important components. The 
recommended video cards are:

NVIDIA Quadro FX Series

FX5800, FX4800, FX3800, FX1800, FX580, FX380
Introduction to Visualization 16 Aug-12
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Framing the Shot
NVIDIA GeForce

GTX 295, GTX 285, GTX 260, 9800 GT

AMD/ATI FireGL

V7700, V8700, V8600, V8650

AMD/ATI Radeon

5800 Series

Rendering Server

If more than one user needs access to a high speed computer you might consider 
creating one rendering server on the network with limited access. With 
MicroStation’s Distributed Rendering tools everyone can take full advantage of a 
powerful machine without the expense of buying multiple machines.

Framing the Shot

When thinking about rendering consider the following:

• Near and Far views (Depth of Field)

• Horizontal vs. Vertical

• Motion or Static

• Light vs. Dark

Composition is a key element in getting started, essentially framing the shot. A 
good way to get started is to pick up your camera and take pictures. Think about 
how you are composing these pictures instead of just pointing and shooting. For 
example, good photos usually have strong horizontal and vertical elements which 
leads to a balanced picture. For Light and Dark consider reviewing the work of 
good black and white photographers, like Ansel Adams. Getting the lighting right 
is critical to a good shot.
Aug-12 17 Introduction to Visualization
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The Rendering Interface
The Rendering Interface

The Rendering tools and utilities are found in the Visualization Task and from the 
pull-down menu Utilities > Image and Utilities > Render.

Rendering Task

The Rendering task is designed with a workflow in mind, as are all Tasks. The order 
of the tools from top to bottom reflects the workflow for Visualization.

Tool boxes in this Task are:

• Render

• Lights and Solar Studies

• Cameras

• Navigate

• View
Introduction to Visualization 18 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



The Rendering Interface
• Materials

• Material Projections

• RPC, Populate and Stencil

• Polygons

• Facet Smoothing

• Animation

Luxology Dialog

The Luxology dialog gives you access to all the settings for Luxology, plus Materials 
and Lights. In addition, this is where you start and view the actual renderings.

The first step when working with the Luxology dialog is to review the Title bar of 
the dialog. The Title bar tells us the:

• Rendering Setup

Title Bar with Setups being used
Aug-12 19 Introduction to Visualization
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The Rendering Interface
• Light Setup

• Environment Setup

You can change which of these setups is being used and the edit them inside the 
Luxology dialog. Setups can be stored in the active DGN or can be referenced from 
an attached DGNLIB.

Luxology Rendering Preferences

The Luxology Rendering Preferences are general settings that rarely need to be 
edited. There will be no need to alter these settings for this course.
Introduction to Visualization 20 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



The Rendering Interface
Light Setups

The Light Setup icon gives access to the Light Manager allowing you to control 
Source and Global Lighting.
Aug-12 21 Introduction to Visualization
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The Rendering Interface
Luxology Environment Settings

The Luxology Environments icon lets you control Fog, Background and Sky 
Lighting. These can be saved as a named Environment.
Introduction to Visualization 22 Aug-12
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The Rendering Interface
Luxology Render Settings

The Luxology Rendering Settings allow you to control general rendering and 
global illumination settings.

Fast Preview

With MicroStation SELECTseries 3, the Luxology Rendering dialog now features 
Fast Preview, a new mode that allows the MicroStation user to quickly and 
interactively see the result of changes to rendering, lighting, and material 
settings. This mode is invaluable for a variety of rendering tasks: everything from 
setting up the right camera view to tweaking materials to perfection is 
dramatically simplified.

When Fast Preview is activated, the scene is transmitted to the Luxology engine as 
though the user had clicked the rendering button. After Fast Preview has been 
Aug-12 23 Introduction to Visualization
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The Rendering Interface
toggled on, changes to rendering-related settings will be reflected in the preview 
window as described below: 

Camera Changes 

Fast Preview uses the view selected in the Luxology Rendering dialog. Any 
changes in position or other camera parameters will be reflected by Fast Preview. 
View options that affect whether or how geometry is displayed will be shown in 
Fast Preview until it is restarted. If the view selected in the Luxology Rendering 
dialog changes, Fast Preview will reflect the camera parameters of the new view. 

Render Settings Changes 

Fast Preview uses the render setup selected in the Luxology Rendering dialog. 
Changes to any settings in the render setup will be reflected by Fast Preview, with 
the exception of the items noted below. For those items, it is necessary to restart 
Fast Preview to see their effect. 

If the render setup selected in the Luxology Rendering dialog changes, Fast 
Preview will reflect the newly selected render setup. 

Settings not supported by Fast Preview: 

• Render Visible Edges 

• Contour Shading 

• Render Geometry Outside View (this is always enabled for Fast Preview) 

• Stereo 

Settings that do not update in active Fast Previews: 

• Ignore Open Elements and Text 

• Stroke Tolerance 

Material Changes 

Once Fast Preview is activated, all material setting changes with one exception 
(explained below) are visible in the preview window. Changes in assignments or 
attachments are not reflected until Fast Preview is restarted. Changes in material 
or palette names may cause inconsistent behavior until Fast Preview is restarted.

The only material setting that will not update properly in Fast Preview is any color 
that is set to “Use Element”. Fast Preview must be restarted to reflect this change. 
Introduction to Visualization 24 Aug-12
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The Rendering Interface
Lighting Changes 

Fast Preview uses the lighting setup selected in the Luxology Rendering dialog. 
Changes to any global or source lights will be reflected by Fast Preview, including 
light position.

If the lighting setup selected in the Luxology Rendering dialog changes, Fast 
Preview will reflect the newly selected light setup.

Note: Non-rectangular area lights are not yet properly supported by Fast Preview. This 
limitation will be removed before the final release.

Environment Changes 

Fast Preview uses the environment setup selected in the Luxology Rendering 
dialog. Any changes to the selected setup will be reflected by Fast Preview. 

If the environment setup selected in the Luxology Rendering dialog changes, Fast 
Preview will reflect the newly selected environment setup.

Geometry Changes 

Fast Preview does not reflect any changes to geometry.

Fast Preview Settings

Fast Preview is controlled by three settings in the Luxology Render Preferences 
dialog. 

Preview Quality: (Draft/Final/Extended Refinement). When Preview Quality is set 
to Draft, Fast Preview renders with the specified number of samples and the 
quality settings in the selected rendering setup scaled by the value in Preview 
Aug-12 25 Introduction to Visualization
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The Rendering Interface
Draft Quality Multiplier. When Preview Quality is set to Final, Fast Preview renders 
at the nearly same quality as your final image (albeit at a lower resolution). When 
Preview Quality is set to Extended Refinement, Fast Preview renders at Final 
Quality and performs additional anti-aliasing passes up to the number specified 
by Preview Samples.

Preview Samples: The number of anti-aliasing passes performed when Preview 
Quality is set to Draft or Extended Refinement.

Preview Draft Quality Multiplier: This setting is used as described in the Preview 
Quality entry. It is ignored when Preview Quality is not set to Draft.

Preview Resolution Limit: This setting limits the largest dimension of the preview 
image. The preview image maintains the aspect ratio of the resolution entered 
into the Luxology dialog. 

Focus Rendering Under Mouse: When this setting is toggled on and Fast Preview 
is active, moving the mouse cursor over a part of the image in the Luxology dialog 
will cause that section to be rendered first. Note that keeping the mouse still will 
not have an effect, so the most effective way to use this option is to wave the 
cursor over the section of image you're interested in.

Redisplay Existing Scene: When Redisplay Existing Scene is toggled on, a new 
scene will not be prepared for the Fast Preview to use when it is started, meaning 
only changes that would be visible while the Fast Preview is active will be shown. 
If that limitation is acceptable, toggling this setting on will dramatically improve 
performance when starting Fast Preview.
Introduction to Visualization 26 Aug-12
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The Rendering Interface
Other Settings

The icons in the lower left of the dialog start with Saving and History commands.

From left to right the icons are:

• Save Image to File

• Save All Image Layers to File

• Copy Luxology Render to Clipboard

• Set Luxology History Folder

• Delete Current Image

• Previous Image

• Next Image
Aug-12 27 Introduction to Visualization
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Display Styles and Luxology
The remaining icons are:

• Background

• Adjust Image Settings

• Stereo Image Type

• Fit to Window

• Zoom Level

• Overlay Visible Edges

Display Styles and Luxology

MicroStation will purposely honor the Display Style overrides so color, 
transparency, material, will be used if the display style is applied to the view that 
Introduction to Visualization 28 Aug-12
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Recipe for good Visualization
you render. The advantage is that you can define a material like chalk and or graph 
paper as a material override and Luxology will render everything with that 
material.

Display Styles can also be created in DGNLIB’s so that all users can use the same 
style.

Exercises in this course will start with Wireframe as the DIsplay Style to Render.

Recipe for good Visualization
1 3D models - First ingredient (not covered)

2 Camera

3 Lighting

4 Materials
Aug-12 29 Introduction to Visualization
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Recipe for good Visualization
5 Render

6 Photo-matching

7 VR Panorama and PDF
Introduction to Visualization 30 Aug-12
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Luxology Rendering Settings
Module Overview

There are a myriad of settings available within the Luxology rendering 
environment. The three critical categories are:

• Render Setup

• Lights

• Environment

Each has many options and each setup can be named and saved in the current 
DGN or DGNLIB. Lights and Light Setups are covered in a separate module.

Another resource is: http://www.vertexmonkey.com/ which has information and 
downloadable tools and materials for Luxology.

Module Prerequisites
• Knowledge of Lighting

• Knowledge of basic rendering capabilities

• Knowledge of Materials

Module Objectives

After completing this module, you will be able to:

• Save and Use Luxology Environments

• Save and Use Luxology Render Settings

• Set Luxology Preferences
Aug-12 31 Luxology Rendering Settings
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Luxology Dialog Review
Luxology Dialog Review

Remember to review the Title bar of the Luxology dialog for Setup, Lights and 
Environment currently being used.

In this case, Setup is Exterior Good, Lights is Untitled and Environment is 
Modeling.
Luxology Rendering Settings 32 Aug-12
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Luxology Render Preferences
Luxology Render Preferences

The Luxology Render Preferences allow you to control some basic technical 
settings for Luxology and your machine. 

As a general rule of thumb you will not need to change these settings for this 
course. For most users the most useful setting here is being able to set the DPI.

Number of History Images 

Sets the number of images that are stored for recall with the Previous/Next tools.

DPI

Set the dots per inch for display and printing.

Units

Sets the units for rendering and saving images. Options are pixels, in(ches), mm, 
or cm.

Bucket Size 

Controls the size (in pixels) of the sub-image “buckets” that are produced during 
the rendering process.
Aug-12 33 Luxology Rendering Settings
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Luxology Render Settings
Number of Threads 

Option menu that lets you select the number of threads used by the Luxology 
rendering engine. This lets you optimize how much processing power is left over 
for tasks besides rendering. 

It is strongly recommended that you do not set this value higher than the number 
of cores available on the computer. For the best rendering performance, set this 
option to Automatic (the default).

Geometry Cache Size (MB) 

Sets the cache size for geometry created by the Material Fur Settings in the 
Advanced Mode settings of the Material Editor dialog.

Luxology Render Settings

Like other setup facilities in MicroStation, this dialog allows you to save named 
setups (like a Text Style) in the active DGN or DGNLIB. 

Several have already been created for you easing the process of creating a high 
quality rendering, without having to know all the settings. In addition, many 
Luxology Rendering Settings 34 Aug-12
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Luxology Render Settings
setups have been created in the PhotoRealistic Rendering.dgn file in General 
examples.

The Render Settings dialog title displays the current render setup settings being 
displayed. Double-clicking an entry in the tree view, makes the setup active for 
rendering.

By putting your pointer over any Render Setup you can see whether it is a local 
setup or a library setup and where it is stored.

Icons in the tree view indicate the state of the render setup as follows:

Local setup. If the name displays in:

• Blue — it has yet to be saved locally. 

• Blue with Checkmark - Local copy matches Library copy.

• Gray —Setup is in a library and not being used in the current file.

Your tools to create New, Save, Update from Library, Import and Delete Render 
Setups.
Aug-12 35 Luxology Rendering Settings
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Luxology Render Settings
Remember, DGNLIB setups appear for your use and you can change the local 
definition but can always update to the library definition.

Quality Slide Control

Lets you quickly adjust keyed values inside the selected render setup. The slide 
control is present also in the Luxology Render dialog. Both slide controls are 
synchronised if the same setup is selected in both dialogs.

Values in the Settings and Global Illumination tabs that may be adjusted with this 
control are indicated by a key icon.

• Keyed setting disabled (ignores slider adjustment).

• Keyed setting enabled (slider adjusts value).

The delivered render setups have the appropriate key values activated. For 
example, the Ambient Occlusion setup, has Occlusion Rays keyed but Irradiance 
rays are not.
Luxology Rendering Settings 36 Aug-12
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Luxology Render Settings
Where you use a custom setting that is outside the normal range, the slide control 
cannot be used to adjust them. For example, the Interior Extreme setup does not 
use a keyed value for Indirect Bounces because it is set to 10. This is far higher 
than what should be used for 99% of renderings and thus outside the range of the 
slider.

Render Output

The output from a Rendering can be seen in a number of different ways. The list is 
shown in the diagram below followed by the description of each.
Aug-12 37 Luxology Rendering Settings
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Luxology Render Settings
Color

Output is rendered with the defined colors and materials.

Ambient Occlusion

Shades the model in such a way as to accentuate its nooks and crannies. Ambient 
Occlusion means that all pervasive and equal ambient lighting is occluded by 
objects within the scene to create shadowing. You can get ambient occlusion 
renders by simply choosing the Ambient Occlusion Setup and hitting the Render 
button. 

Setting the Output to Ambient Occlusion is equivalent to using all white diffuse 
surfaces lit by a white environment. For example, if half the rays coming from the 
point being shaded hit geometry, then the point is half occluded and will be 50% 
grey. If all the rays hit geometry, then the point will be black. If no rays hit the 
geometry, then the point will be 100% white.

Ambient Occlusion uses Global Illumination to perform the rendering. The quality 
of the Ambient Occlusion pass is dependent on the number of Occlusion Rays 
used. The default value of 257 produces high quality results. You can improve 
performance (at the expense of quality) by decreasing the number of Occlusion 
Rays to 64 or less.
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Luxology Render Settings
Note: Ambient Occlusion works best for exterior scenes, as most interiors would 
probably be completely in shadow. However you could use a clip mask, or clip 
volume to remove the roof and even a few walls thereby allowing un-occluded 
ambient light to reach the surfaces of an interior scene using Ambient 
Occlusion.

Depth

Produces grayscale images where the values are based on the distance from the 
back-clipping plane or, if one is not defined, the back of the geometry visible in 
the scene. Lighting has no effect when using Depth output. This option can be 
used, for example, to create a displacement map from existing geometry. Where 
required, you can use a selection set to include multiple elements in the 
displacement map.

The depth output image also can be used with 3rd party image editors to quickly 
produce high quality Depth of Field effects by using lens blurring filters.

Shadow Density 

The Shadow Density rendering output renders a channel generated from the 
density of all direct light shadows in Luxology exclusive of color shading or 
texture. The darkest areas of shadow render as white ramping toward black for 
the areas that would be fully illuminated. When rendering in layers, it is very 
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useful to have shadows rendered separately giving one control of color and 
transparency. You could easily invert this channel in an image editing application 
and layer it over the unshadowed render set to multiply, giving control over how 
dark the shadows are based on the layers transparency.

Reflection Shading 

The Reflection Shading output generates a channel of all the reflection calculated 
within a scene independent of all other attributes.

Specular Shading 

The Specular Shading output generates a channel of all the Specular shading 
within a scene independent of all other attributes.

Subsurface Shading 

The Subsurface Shading output generates a channel of all the subsurface 
scattering shading within a scene independent of all other attributes.

Transparent Shading 

The Transparent Shading output generates a channel of all the Transparent 
shading within a scene independent of all other attributes.

Illumination Direct 

The Illumination Direct output generates a channel exclusive to the illumination in 
a scene from all direct light items such as distant lights, area lights, point lights 
and spot lights, independent of all other surfacing attributes.

Illumination Indirect 

The Illumination Indirect output generates a channel exclusive to the illumination 
in a scene from all indirect sources such as image based lighting and luminous 
polygons, independent of all other surfacing attributes.

Illumination Total 

The Illumination Total output generates a channel of the full illumination in a 
scene including shadows cast by direct sources, independent of all other surfacing 
attributes.
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The images below show the Color image (left), then the Ambient Occlusion in the 
center, and finally overlaid to create image on right.

Output Examples 

As you might be able to imagine, being able to use these outputs in an image 
editor such as Adobe's Photoshop allows you to create some rather interesting 
and dramatic results when these layers are combined. For instance, maybe you 
want an ambient occlusion render but you want your glass to look realistic with 
transparency and reflections. Perhaps you want to use the dirty shadows from an 
ambient occlusion render to add more interest to your final color render.

The following exercise will have you create a Rendering setup in a DGNLIB that 
you can use throughout the course.

 Exercise: Creating a new Rendering Setup

1 From File Open select:

User: untitled

Project: Rendering

2 Navigate to ...\Rendering\dgnlib\ and open Rendering.dgnlib.

3 From the Visualization task select Render (Q + 1).

4 In the Luxology dialog select Render Setups.
Aug-12 41 Luxology Rendering Settings
Copyright © 2012 Bentley Systems, Incorporated



Luxology Render Settings
5 In the Render Setups dialog select New and name the new setup: Quick 
Ambient Occlusion.

6 Set the following:

7 Click on Save.

8 Once a Setup is created it is then available from the options list.

Bloom

In photography, when a very bright part of an image neighbors a very dark part, 
the bright part appears to glow; this phenomenon is known as Bloom. Luxology 
Bloom simulates this effect by removing excess energy from a pixel and 
distributes it to its neighbors. You can turn on the Bloom option to get this effect. 
Bloom settings are on the Advanced Tab.

Bloom Distance

Sets the distance in pixels that energy is distributed, controlling the size of the 
glow. Increasing this value enlarges the bloom effect.
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Bloom Threshold 

Sets the lower threshold to which pixels are effected by Bloom. Lower values 
mean less bright pixels are affected by bloom.

Bloom Radius

Set the Radius of the Bloom effect. Higher number results in a larger Bloom.

Caustics

In optics, a caustic or caustic network is the envelope of light rays reflected or 
refracted by a curved surface or object, or the projection of that envelope of rays 
on another surface. Caustic can also refer to the curve to which light rays are 
tangent, defining a boundary of an envelope of rays as a curve of concentrated 
light. Therefore in the image to the right, the caustics can be the patches of light 
or their bright edges. These shapes often have cusp singularities.

Such concentration of light, especially sunlight, can burn. The word caustic, in 
fact, comes from the Latin causticus, or burning. A common situation where 
caustics are visible is when light shines on a drinking glass. The glass casts a 
shadow, but also produces a curved region of bright light. In ideal circumstances 
(including perfectly parallel rays, as if from a point source at infinity), a nephroid-
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shaped patch of light can be produced. Rippling caustics are commonly formed 
when light shines through waves on a body of water.

Another familiar caustic is the rainbow. Scattering of light by raindrops causes 
different wavelengths of light to be seen in arcs of differing radius. Each such arc is 
a directional caustic. Caustic settings are located on the Advanced tab under 
Global Illumination.

Total Photons 

Sets the total number of photons shot into the scene.
Luxology Rendering Settings 44 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Luxology Render Settings
Local Photons 

Sets the number of local Photons used and indicates the number of photons 
required for each pixel sampled. When the pixel is rendered, a search along the 
surface locates the nearest photons up to the local photon count. The default 
setting of 32 indicates that 32 photons will be used for each pixel rendered.

Indirect Caustics 

If enabled, caustic effects from indirect lighting are calculated. Indirect caustic 
effects are those of light accumulation on a surface after reflecting or refracting 
from another surface. For example, the light pattern on a table as it is cast 
through a wine glass. For caustic effects, from indirect illumination, you can select 
from four options in the menu.

• None — No indirect caustics are rendered.

• Reflection — Only reflected indirect caustics are rendered.

• Refraction — Only refracted indirect caustics are rendered.

• Both — Both reflected and refracted indirect caustics are rendered

Sub Surface Scattering

Subsurface scattering is the effect of light bouncing around inside a material and 
being “tinted” prior to exiting. This is often most obvious in materials like cloth, 
marble, wax, or translucent liquids.

With Direct Only enabled, rendered images still can contain effects from both 
indirect illumination as well as Subsurface Scattering, but the two will not affect 
each other. This is the default behavior for speed reasons. 

When either or both of the indirect illumination settings are enabled, indirect 
illumination rays will be considered when evaluating Subsurface Scattering 
effects, with a resulting increase in the rendering time.

• Direct Only — Direct lighting only is considered.

• Indirect Affects Scattering — Indirect lighting is considered when calculating 
subsurface scattering.

• Scattering Affects Indirect — Subsurface scattering is considered when 
calculating indirect lighting.

• Both — Both the indirect lighting, and the effect of subsurface scattering on 
indirect lighting, are considered in the rendering.
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Depth of Field

Depth of field refers to the range of distances that an image is in focus for a given 
lens aperture. Objects beyond that range typically will appear somewhat out of 
focus — the further outside the range, the more out of focus. When an image is 
rendered with Luxology and the Depth of Field toggle is on, changes in focus will 
be rendered.

When Depth of Field is enabled, the f-Stop field also is enabled. In this field, you 
can key-in, or select from a drop-down menu, an f-Stop for the camera lens (lens 
aperture) to simulate the depth of field of a camera.

Associated with this setting is the Focal Distance setting for the Camera Position 
settings in the Define Camera tool.

Rendering depth of field effects can be very expensive in terms of render time. To 
get decent Depth of Field (DOF) results, you will need to set your antialiasing (AA) 
samples to at least 64 and to get very good results you will need to set the AA 
samples to 256. 

While the rendered DOF results can be very good, if you have a copy of 
Photoshop, you can quickly and easily accomplish DOF effects, and with even 
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better results, by using a Depth Map in conjunction with Photoshop's Lens Blur 
filter.

Luxology Environments

What is an Environment?

An environment is simply your surroundings; if you look around the space where 
you are sitting, everything that you see is your current environment. Getting up 
and moving to a different position would result in your environment changing. In 
MicroStation, the environment you specify can provide indirect light, reflections 
and refractions to your scene. As this document will illustrate, these extra touches 
are key to creating believable images.

However, there’s one important caveat before we get started with Luxology 
environments. If you’re rendering an interior scene, it’s only worthwhile to use an 
environment if there is at least one opening that allows in light from the outside 
(this can include geometry with transparency or translucency). If no light from 
outside the scene is able to enter the room, there won’t be any illumination, 
reflections or refractions visible from the environment and the Luxology engine 
may perform unnecessary calculations, potentially lengthening the time needed 
to complete rendering. Rather than use an environment, instead try to populate 
the scene as realistically as possible with furniture, paintings and other objects. 
These will provide the reflections and refractions that an environment would 
otherwise.

Side note: if you’re in need of models for these incidental objects, an excellent 
resource is the Entourage community here on the Be Communities. It features 
models from both Bentley Systems and Bentley software users, with more added 
each day. It costs nothing to join, so anyone with even a passing interest in 
visualization using Bentley products should definitely be a member.

Getting Started with Environments

By default, each design file opened with MicroStation will have the following 
named environments available: Alley, Fog, Gradient Sky Blue, Material Preview, 
Physical Sky and Probe Park Sunny. If you’ve read this far in the document, these 
environments can be effectively used without understanding any other 
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environment settings. Each of these default environments will provide light, 
reflections, refractions and a visible background to your scene.

Alley and Probe Park Sunny will provide, as you might expect, environments that 
resemble an alley and a park. Gradient Sky Blue uses a blue gradient to give the 
effect of a clear sky, while Physical Sky provides a realistic sky (including the sun) 
based on your solar position and time of day settings. Material Preview is the 
environment used by the Material Editor when generating previews – you can use 
this environment to quickly generate images that give you an idea of how realistic 
light would interact with your scene.

While the default environments can all be used to great effect, the key to 
unlocking the true power of Luxology environments is to understand the settings 
that make each environment what it is. After that, you can begin to customize and 
create your own environments.

If you’d like to add more environments to the list of those available by default, you 
can create a DGN Library file and use the Environment Settings dialog to save 
environments to that file. Once this is done, place the dgnlib you’ve created in a 
path where MicroStation looks for DGN libraries. Do not modify the delivered 
dgnlib – otherwise, you may find that your custom environments are lost with 
your next MicroStation update.
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Basic Environment Settings

Each environment has four Visibility options: 

Camera

Determines if the environment is visible through the camera. It is one way to 
control whether the environment is used as the background for your scene.

Indirect

With Indirect turned on, an environment will produce indirect light and can be 
used to illuminate a scene. It is possible to have all the lights off in a model and 
yet still get light from the environment with Indirect on.
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Reflection

If Reflection is enabled, the environment will be shown in materials that are 
reflective. 

Refraction

If Refraction is enabled, the environment will be able to be seen through 
transparent materials.

Many users find that even if they do not want to have a particular environment 
visible in their scene, the reflections and refractions offered by an environment 
are very valuable. To see a setup like this, try turning off Camera visibility and 
leaving the other settings enabled.

It is important to note that all environments can produce indirect light. The 
amount of light produced can be adjusted using the brightness slider in the 
Environment Settings dialog. To use only the indirect light produced by the 
environment, enable Override Existing Lights.
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Environment Types

MicroStation supports five different environment types: Sky, Light Probe, Image, 
Image Cube and Gradient.

Sky

The scene will be illuminated by the physical sky color, which is determined by 
settings in the active Light Setup (including time of day and geo-location). If solar 
lighting is not enabled in the active Light Setup, this environment will have no 
effect. Additionally, if the time of day is set such that the sun is below the horizon, 
the amount of indirect light generated will be minimal and the sky will be black.

Rendered using Sky with Bloom

This environment also provides the option to set a size for the sun. Larger values 
for this field increase the sun’s size and can provide dramatic telephoto lens 
effects.

 Exercise: Creating a Sky Environment

1 Continue in Rendering.dgnlib.

2 From the Luxology dialog select Luxology Environment Settings.

3 In the Environment Settings dialog select New and name the new 
environment Morning Sky.
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4 Set the following:

5 Use the default Visibility settings.

6 Click on Save.

Remember Sky relies on the Solar Light setup.

Light Probe

Light probes are a special kind of image environment. They are made by 
photographing a mirror ball on a tripod with a camera on another tripod. Multiple 
exposures are taken by moving the camera in a circle around the sphere. The 
result is an image with high dynamic range. Therefore, light probes can provide 
higher quality reflections and indirect lighting.
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High Dynamic Range (HDR)

HDR images are a special type of image that contains more information per pixel 
than simply color values. Each pixel contains a range of values depending on the 
number and exposures of input images. this range can then be expressed as 
lighting, and the range will extend from the brightest white to the darkest black in 
the image. A jpg image has a contrast ratio of 256:1, most high dynamic range 
images are between 1,000:1 to 50,000:1.

While they can be any image format, the most common type is the High Dynamic 
Range format (.hdr). Many light probes are available for downloading on the 
internet; in particular, Bentley recommends using the Unparent Light Probes 
(http://www.unparent.com).

L: No Environment C: Light Probe Overridden

The above images are an example of how important an environment can be in 
producing realistic renderings from real world models. In the first image, no 
environment is used and there is nothing to reflect but the background color. This 
produces an almost monochromatic image, making the stainless steel material 
look nothing at all like stainless steel.

In the center image, a light probe is used with Override Existing Lights enabled. 
Once the stainless steel material has an environment to reflect, it changes 
dramatically and looks like the stainless steel we have seen in the real world. It is 
almost hard to believe this is the same material that was used in the first image.

In the right-most image, the same light probe is used with Override Existing Lights 
disabled. With multiple light sources active (in this case: solar light, ambient and 
the light probe), the image takes on a softer quality but the stainless steel 
continues to look accurate.

While light probes are very useful and memory-efficient for providing quality 
indirect lighting, reflections and refractions, they tend to be lower resolution and 
thus often inappropriate for use as a high quality background. To work around this 
limitation, you can turn Camera visibility off for a light probe and specify a 
background image in either the Environment Settings dialog or, once your image 
is rendered, in the main Luxology dialog.
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MicroStation’s light probes do not produce direct light. Although the Luxology 
engine supports this feature, Luxology recommends against making use of it. 
Direct light from light probes tends to dramatically increase time spent rendering 
without any visible gain in quality. As such, we will not be implementing this 
feature in the future.

 Exercise: Creating a Light Probes

1 Continue in Rendering.dgnlib.

2 In the Environment Settings dialog select New and name the new 
environment California Sky.

3 Set the type to Light Probe and click on the magnifying glass to browse for 
the file.
Luxology Rendering Settings 54 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Luxology Environments
4 Navigate to ...\Workspace\Projects\Rendering\images\ and select 
beverlyHills_sun_probe_FINAL.hdr

5 Click on Save.

These environments allow you to select any kind of image and a method for 
projecting that image as your environment. The possible projections are Planar, 
Cylindrical, Spherical, Cubic and Front.

With a Planar projection, the image is laid out in a plane. Currently, this projection 
would only be useful if you’re rendering in a top view. The ability to offset, scale 
and rotate environment projections dynamically will be added in the future, 
making this mode much more useful.
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A Cylindrical projection wraps the image around the scene as a cylinder. In 
addition to the dynamic projection adjustments mentioned above, the option to 
mirror or repeat the image along its seams will also be added in the future.

When a Spherical projection is used, the image is projected as a sphere 
encompassing the scene.

With a Cubic projection, the image is applied to the six faces of a cube 
encompassing the scene. This method works similar to the way environments 
were applied in previous versions of MicroStation; these older environments were 
often referred to as “Sky Boxes”. However, this mode does not allow a different 
image to be specified for each face (an Image Cube environment can be used to 
mimic the old behavior).

A Front projection applies the image to the front plane of the scene, always 
aligned with the camera. If the image is visible, its orientation should be identical 
to that of a background image. There is little to gain from using this mode because 
turning on Camera visibility negates being able to change the background image 
once the rendering is complete, and the reflections visible from this mode do not 
look as convincing as cylindrical or spherical mapping.

Because Image environments can be higher resolution, they are viable choices for 
sources of background, indirect lighting, reflections and refractions. Using an 
Image environment can be more memory intensive than using a Light Probe 
environment, so this may not be an option in all scenes.
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Image using Cylindrical projection visible to all but Camera. Background image 
used for visible background.

Image Cube

This environment type assigns an image to six sides of a cube that surrounds your 
scene. This method is identical to the method MicroStation used for its legacy 
rendering modes (Ray Trace, Particle Trace and Radiosity). When using an Image 
Cube, you can rotate the environment about the global z-axis.

If the environment is made visible to the Camera, specialized images should be 
used that are intended for a sky box. These images are warped to appear correct 
when seen from inside of the box so that they display without visible corners or 
seams.

Proper Image Cube imagery can be time consuming to create. The first step is to 
create a seamless 360 panorama image. After that, map the image to a cylinder 
using MicroStation. Render the Front, Right, Left and Back images by rotating a 90 
degree camera located in the center of the cylinder. For the Top and Bottom 
images, the camera looks straight up and down. Each of these images must then 
be edited in an image editor, and the holes in each section must be artistically 
filled or painted with a convincing sky or ground image.

Rendered with Image Cube visible to Camera, Reflections, Refractions and 
Indirect Light.

Gradient 

The environment is made up of a gradient between either 2 or 4 colors. A 2 Color 
gradient is a straightforward interpolation between the selected Zenith Color for 
the high end and the selected Nadir Color for the low end.

With a 4 Color gradient, the selected Sky Color and Ground Color are also used. 
Each has an associated Exponent value that controls the percentage of Sky or 
Ground Color used in the gradient. Using a low value (such as 0) for both 
Exponent values would result in only Ground Color and Sky Color being used in 
the gradient with no mixing of Zenith or Nadir Colors. Using an Exponent value of 
4 for Sky Color and 0 for Ground Color would result in some mixing of Sky Color 
but no mixing of Ground Color with Nadir Color.

The diagram below illustrates these concepts. In it, a reflective sphere was 
rendered with the environment visible to the Camera. Note that the camera used 
is a front view with some perspective added.
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Colors used

You can see that as the Exponent values are increased, more of the Zenith and 
Nadir Colors appear in both the reflections and the visible sky. The default 
Exponent values for Sky and Ground Color are 8.0, which provide a fairly even 
distribution of the gradients in the visible sky.

 Exercise: Creating a Gradient

1 Continue in Rendering.dgnlib.

2 In the Environment Settings dialog select New and name the new 
environment Dusk Gradient.

3 Set the type to Gradient and set the colors as follows:

Zenith Color: Red: 155, Green: 40, Blue: 40

Sky Color: Red: 255, Green: 200, Blue: 120

Ground Color: Red: 145, Green: 115, Blue: 90

Nadir Color: Red: 41, Green: 51, Blue: 51

Ground 0 
Sky 0

Ground 0 
Sky 1

Ground 1
Sky 1

Ground 2
Sky 2

Ground 4
Sky 4

Ground 8
Sky 8

Ground 10 
Sky 10

Changing Exponent Values
Luxology Rendering Settings 58 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Luxology Environments
Keep other settings at default.

4 Click on Save.

Other Environment Settings

With the Luxology dialog, it is possible to replace the alpha pixels in a rendered 
image with either a solid color or image background. The Background options in 
an environment allow you to store your background settings for use in other 
rendering dialogs like Save Multiple Images or Record Script. Because both an 
environment and a Background will replace the alpha pixels in your image, these 
options cannot be used at the same time.

The alpha channel is a mask, letting some background information through and 
blocking other pixels. it specifies how the pixel's colors should be merged with the 
background pixel.
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Enabling Fog produces an exponential fog effect that increases intensity as it 
moves farther from the camera. If the fog’s Density is increased, it becomes 
uniformly thicker. A color can be either manually specified, or if Use Environment 
Color is enabled, the environment color will dynamically adjust the fog’s color. 
The latter option often produces spectacular results.
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Luxology Level Filters in the Level Manager

If you have certain geometry that you do not want to display when working in 
MicroStation but do want to render in Luxology, you now have the option to place 
that geometry on a level contained in a filter named Luxology_On and have it 
render regardless of its display state in MicroStation. To accomplish the inverse 
effect, place a level into a filter with the name Luxology_Off.
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Module Overview

The first step in creating a rendering is to decide on how you want to display your 
design. You need to view your design much like a photographer would before he 
takes a picture. Consideration must be given to the view angle, camera elevation, 
lens settings, and solar orientation. In this module you will have an opportunity to 
create various views of a bridge structure.

Module Prerequisites
• Basics of MicroStation 3D view control and AccuDraw.

Module Objectives

After completing this module, you will be able to:

• Create a view at any angle and elevation

• Change lens settings within your view

• Manipulate your camera to modify your view

• Learn to use the Photomatch capability, for placing a model in the foreground 
of a photograph
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Introductory Knowledge

Before you begin this module, let's define what you already know.

Questions

1 What is a perspective view?

2 What are saved views?

Answers

1 A view of an object that shows the height, width, and depth of a 3D 
model. Perspective viewing includes one point, two point, three point and 
parallel projections.

2 View definitions that include the level display of the active file, references, 
clip volume and attributes. After you create a scene you can save the view 
using the Saved View dialog.
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Camera Tools 

All of the tools necessary to create a scene for rendering are located in the 
Cameras tool within the Visualization task.

The Setup Camera tool (E + 1) is used to define the active view, projection type, 
reference point, lens, camera position and target point when creating a scene for 
rendering.

In this example two right isometric views are open and view 2 is the active view.
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Select the Setup Camera tool with the following settings:

Enable Camera Height: 100 MU (This will set the camera height 100 units above 
the selected screen position).

Select the Active view, (view 2) then place a data point in view one to define the 
camera position. The actual position will be 100 units above this data point. The 

next step is to place a data point on the target point. The active view, view 2, will 
then rotate based upon these selected view points.

Active view results after entering camera position and target point
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The Define Camera tool (E + 2)is used to control the movement and settings of the 
camera. You can manipulate the camera view cone in the other views or you can 
use the advanced tools from the Define Camera tool settings to manipulate the 
view camera. 

With the Define Camera tool, you can manipulate the view cone using the 
handles that appear at the eyepoint, target, center and a fourth handle that lets 
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you alter the viewing angle. The target handle is located at the center of a 
rectangle that represents the image plane.

Using these handles, you can manipulate the view cone as follows.

• Camera handle — positions the camera or eyepoint relative to the target.

• Center handle — position the entire view cone without changing the relative 
positions of the camera and target.

• Target handle — positions the target relative to the camera or eyepoint.

• Viewing Angle handle — changes the viewing angle of the camera. Reducing 
the view angle is equivalent to using a telephoto zoom lens. Without moving 
the camera or target locations, you can zoom in or out by changing the view 
angle.

To change the position of a view cone handle

1. Enter a data point on the handle that you want to move.

2. Move the handle to the new location.

3. Enter a second data point to complete the change.

You can enter a data point on the handle and hold down the data button as you 
move the handle. Releasing the data button completes the move.

You need 2 views open to quickly manipulate the view cone. For example, you can 
use the Top view to manipulate the view cone horizontally and the Front or Right 
views to manipulate it in the vertical direction. In the following example view 2 is 

Camera Handle

Center Handle

Target Handle

View Angle Handle
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a right isometric view and view 1 is the active view. Manipulating the Display View 
Cones in view 1 with AccuDraw assistance will dynamically modify the active view.

The Camera position handle was moved and the lens handle was moved to a wider lens opening.

 Exercise: Using the Define Camera tool

1 From File Open select:

User: untitled

Project: Rendering

2 Open the file 01_Camera.dgn and open the model 01_Bridge.

3 Select Define Camera (E + 2) with the following tool settings:

Continuous View Updates: Enabled

Display View Cone: Enabled

Projection: Three Point

You are prompted to Select active view.

4 Enter a data point in View 2.
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This becomes the Active View, as shown in the Define Camera tool 
settings. The View Cone for the selected view appears in the remaining 
views.

5 Enter a data point on one of the view cone handles in View 1, 3 or 4. Zoom 
out if you have to.

6 Rotate the camera by selecting the red, green or blue axis and move your 
cursor along the AccuDraw compass that displays at the camera position.

7 Observe that the camera view (View 2) updates continuously as you 
manipulate the view cone. 

If you disable Continuous View Updates, the view updates after you have 
moved the handle.

Try all the view cone handles to see how they relate to each other.

Using the view cone and a camera view in this fashion gives you visual feedback 
on just what the camera view is displaying. Currently, the Projection is set to 
Three Point, which displays the camera view much as you would see it through a 
normal camera.
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Note: You can also manipulate the view by moving the cursor in View 2 and selecting 
one of the tool settings icons for specific actions. By clicking on More, you can 
display windows to enter specific numerical data for camera manipulation.
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Camera action options

There are 9 icons across the top of the Define Camera tool settings which let you 
control the camera view cone directly. These icons match options in the Camera 
Action option menu.

 Exercise: Using a camera action tool

1 Continue in the file 01_Camera.dgn and model 01_Bridge.

2 From the Visualization task, select Define Camera (E + 2), in the tool 
settings, set the following:

Active View: 2

Projection: Three Point

Reference Point: Target

Continuous View Updates: Enabled

Display View Cone: Enabled

3 Click Pan.

4 Enter a data point at the center of the camera view (View 2).

5 Move the pointer:

Left/right to rotate the camera (eyepoint) left/right about the target point.

Up/down to rotate the camera up/down about the target point.

This is similar to moving around a stationary object (the target).

6 Reset to return the view to its original orientation.

Camera Option Effect

Pan Move the camera or target radially relative to each other, either horizontally or 
vertically.

Pan Horizontal Move the camera or target radially (horizontally) relative to each other

Pan Vertical Move the camera or target radially (vertically) relative to each other.

Roll Roll or tilt the camera.

Dolly/Elevate Move the camera sideways or vertically.

Dolly Move the camera in, out, or sideways.

Lens Focal Length Change the lens focal length.

Lens View Angle Change the Lens View Angle

Pan/Dolly Walk through the view.
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7 In the tool settings, set Reference Point to Eye.

8 Move the pointer:

Left/right to rotate the target point left/right about the camera.

Up/down to rotate the target point up/down about the camera.

This is similar to standing in the one spot and turning your head left/right/
up/down to view the surroundings.

9 Reset to return the view to its original orientation.

Try the other camera action options in the Define Camera tool settings. 

Standard Lens = Fish Eye

Standard Lens = Normal

Standard Lens = Telescopic

There is another tool that can be used to change the focal distance of the camera 
lens and that is the Focal Distance tool. With this tool you simply move the cursor 
forward or backward in the active view or move the cursor in an orthogonal view 
to change focal distance. In an orthogonal view, the yellow portion of the camera 
icon, expands or contracts to reflect a change in focal distance. This tool is 
typically used to change the depth of field in a scene.
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Controlled Movement

You have the option to move or rotate the camera view cone by a defined 
distance/angle. To do this, you must disable Continuous View Updates and use 
data points to specify movement. The amount of movement or rotation per data 
point is specified in the Controlled Movements settings. Open more options using 
the drop down arrow in the tool settings.

For view cone manipulation with data points, the position of the data point in the 
view determines the direction of the movement or rotation. If you think of the 
view as being divided into 9 sections, then the movement performed by a data 
point in one of these sections is as shown in the diagram below.

Saved Views dialog

Used to name, save, delete, import, apply and recall saved views. Saving a 3D view 
allows you to quickly recall a view with specific attributes. It is important to create 
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and use Saved Views in 3D, since you will want to return to a known position 
many times. They are helpful for design, navigation, rendering and animation. 
Camera and Clip Volume settings are available for saving or recall.

Open the dialog by selecting Utilities > Saved Views, or Tools > Views > Saved 
Views or selecting View Save/Recall from a view window control menu, or 
pressing F6.

Understanding the Saved Views dialog

The Saved Views dialog contains controls that are used to apply a saved view to a 
view in the design file. The list box shows the name, description and model of 
each view saved. To apply a saved view, use the following options:

Apply to Selected Views. Select this tool and click in a selected view window.

Apply to open views. All opened views will display the Saved View.
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Double click the entry in the Saved View dialog list will display the Saved View in 
the Active View.

Active File

This icon displays optional settings by clicking on the drop-down list box.

Note: A link is a pointer to project data and a link set is created when you use 
Project Explorer (File > Project Explorer).

Create Saved View 

Opens the Create Saved View dialog where you name and describe the view you 
are saving. The view can be a saved, section, elevation, detail or plan view. A Clip 

Volume can also be added to a Saved View Option or a Dynamic View can be 
created.

 Exercise: Create a Saved View

1 From File Open select:

User: examples

Project: Plant

2 Open Workspace\Projects\Examples\Building\Designs\BSI700-S0501-
UnloadingPlatform.dgn, and open Views 1 through 4, select to Window > 
Tile, and then Fit View (4 + 5) for each view.

3 Set Display Style to Wireframe for each view.
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4 Window in on the top of the Unloading Platform in View 4 (Right View).

5 Set Display Mode to Smooth with Shadows and apply the View 
Perspective Extra Wide Angle. Pan and Rotate to adjust if needed.

6 Press F6 to open the Saved View dialog, click Create Saved View, and save 
the new view in View 4:

Name: Top Platform 

Description: Top platform with wide angle view

7 Click in View 4 to select the source view.
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8 In the Saved Views dialog, set the View number to View 3 and double click 
the Top Platform saved view in the saved view list box.

9 In the Saved View dialog list box, click on the area below the header “Clip 
Volume” to select an existing clip volume.

10 Select File > Close.

Other Camera Setups

The procedure for setting up an interior camera is essential the same as it is for 
exterior camera setup. In order to see inside a building you will need a camera 
inside it. Using AccuDraw is critical to placing the camera properly.

In addition, you can use Clip Volumes to isolate an section of a building and see 
inside the building or structure.

In the following exercise you will create a clip volume and place a camera and 
Render with Ambient Occlusion. The following file is built from References.

 Exercise: Setting up a camera for interior or clip volume shots

1 From File Open select _MasterRender.dgn.

2 From the View Border of View 2 select Clip Volume (4 + P).

3 In the tool settings select:

Section Clip Tools
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Apply Fitted Section YZ Plane

4 Enter a data point in view 2.
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You can manipulate the Clip Volume by interacting with blue bolt icons or 
move the plane with the green arrow icon in the center of the view.

5 From the Visualization task select Setup Camera (E + 1).

Follow the prompts.

6 Enter a data point in View 2.
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7 In the Top view snap to the end of the main building on the right as shown, 
and press F11 (to put focus on AccuDraw), then press <0> to place an 
AccuDraw origin. Do not press the data button.

8 Move your pointer in to the Right view and press <F> to rotate the 
compass to the Front view.

Note whether you snapped to the roof or the floor.

9 Index to the Y axis and enter a value of 12.
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10 Define the target of the camera as the HVAC ducts in the back.

11 Enter a data point after you have snapped to the ducts.

Results in View 2

 Exercise: Render with Quick Ambient Occlusion

1 Select Render (Q + 1).

2 Use the following settings:

Setup: Quick Ambient Occlusion
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Lights: DaylightMorning

Environment: Morning Sky

3 Render View 2 with these settings.

4 Background color can be changed after the rendering is done.

5 Select Define Camera (E + 2) and using the handles in the other views 
move the camera to a perspective shot and re-render.
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Photomatching

Photomatching is the process of adjusting the view camera to match the 
perspective of a photograph, or rendered image. This is done by matching points 
in the photograph to the equivalent points in your 3D design. Using 
photomatching, you can create a rendered image of your design overlaying 
existing conditions (in the photograph).

MicroStation’s Photomatch tool lets you quickly and precisely match geometry in 
a 3D model to an existing photograph.

Left image is a scanned photograph of existing conditions and right image is a rendering of new design with existing photograph.

Match Design Geometry to a Raster Reference

To get the best results on the first try you need to set up a camera view that 
closely matches that of the photograph. This camera view does not need to be 
matched perfectly, but should be somewhat close to make it easier to choose and 
match points in the 3D model to those in the photograph. By matching known 
points in the design to equivalent points in the photograph, the system refines the 
camera view to accurately match the perspective of the photograph. 

Once this step has been completed, the view can be rendered to display the 
design geometry merged with the existing conditions.

 Exercise: Set up the initial camera view size

1 Continue in 01_Camera.dgn and open the Model 02_Photomatch.

The file has been saved with Top and Front views displaying elements 
representing the existing buildings. These elements, on level existing 
house, will be used to align a camera view to a photograph. Once 
matched, the existing house level will be turned off, and the levels 
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containing the proposed building addition geometry will be turned on for 
display.

2 Select Utilities > Image > Display.

3 In the Display Image dialog box, select IMG0017.JPG from the course 
\Textures folder. Enable the Preview option and note the size of the image.

The image size located in the header of the image helps you match the 
view’s aspect ratio to the image.

4 In Visualization task select the View Size tool (T + 1).

5 Enter a data point in View 3.

6 Set the following in the tool settings:

Maintain View Parameters: enabled

Proportional Resize: disabled

X: 768

Y: 512

7 Enter a data point in View 3 to apply these values and resize the view.

The view is resized to 768 pixels by 512 pixels, which may be too large to 
display properly in the MicroStation application window. However, once 
you have established the proper aspect ratio (768 x 512) you can use View 
Size again, this time enabling Proportional Resize to maintain the aspect 
ratio. Once enabled, you can set either the X or Y value and the view size 
ratio will remain intact.

8 Close the Image Display

Next, you will attach a background image for View 3.
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 Exercise: Attach a background image to the resized view

1 Continuing in 01_Camera.dgn, model 02_Photomatch, select Settings > 
Design File.

2 In the Design File Settings dialog box, select the Views category.

3 Set View to 3, enable Background Image, and click the magnifying glass.

The Select Background Image dialog box opens.

4 In the Select Background Image dialog box, navigate to the course 
Workspace\Rendering\images directory and select the file IMG0017.JPG.

5 Click Open in the Select Background Image dialog box.
Visualizing a 3D Design 86 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Photomatching
6 Click OK in the DGN File Settings dialog box to close accept the settings 
and close it.

Background image with geometry in Isometric View

As you can see, the geometry is not even close to being aligned with the 
background image. You need to first use the camera tools to get a rough 
alignment between the geometry and the photograph. Later you will use the 
Photo Matching tool to precisely match the perspective of the model to that of 
the image.

 Exercise: Use the camera tools to align the geometry to the photograph

1 Continue in 01_Camera.dgn, in the Rendering task, select the Define 
Camera tool (E + 2).

2 In the Define Camera tool dialog box, set the following:

Active View: 3

Projection: Three Point

Continuous View Updates: On

Display View Cone: On

3 Fit views 1 and 4 then reset to see view cones.

This fits the views, including the camera cone.
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4 Use the camera controls to manipulate the camera target point, eye point, 
and so on, to roughly match the geometry to the equivalent points in the 
photograph. This will put your view camera in a position similar to the one 
used to take the photograph that you are trying to match.

The initial alignment can be very rough. You do not need to spend much 
time trying to align the background to the geometry. You could even skip 
this procedure, placing the camera approximately where the photo was 
taken from and the camera target in a position roughly where it would 
have been in the original photo.

Rough approximation to match geometry to background image

5 In the View Attributes dialog box (Settings > View Attributes), turn off 
Background for View Number 3, to turn off the display of the Background 
image.

Note: In cases where you do not have known image points modeled in 3D model 
space it is possible to achieve a suitable match using the previous procedure, 
although this method can be time consuming.

Your model now is ready to use the photomatch tool to precisely match the 
geometry to a background photograph.
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Making adjustments with the Photomatch tool

With the view roughly lined up with the image, you can now use Photomatch to 
make the fine adjustments to the camera view so the design file geometry 
accurately matches the photograph.

 Exercise: Using Photomatch

1 Continue in 01_Camera.dgn, enable AccuSnap.

2 In the Rendering Tools tool box, select the Photomatch tool (E + 3).

You are prompted to Select View For Photomatch.

3 Enter a data point in View 3.

4 In the Select Photomatch Image dialog box, select 
Workspace\Projects\Rendering\image\IMG0017.JPG and click OK.

The image is attached to view 3 as a raster reference and you are 
prompted to enter a design file point. You may need to adjust the location 
of the image in the Raster Manager to get the image close to the 
perspective of the geometry.

In the next few steps you will be selecting design file match points, 
snapping first to the geometry, accepting and then matching 
corresponding points to the photo.

5 In View 3, snap to the apex of the left building’s roof line, and accept with 
a data point.
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You are now prompted to Enter image point. There may be a slight 
hesitation as the magnifier loads and displays a magnified portion of View 
3 with cursor lines showing the pointer location. As you move the pointer, 
the image in the magnifier updates to keep the lines at the pointer 
location. By default the magnification is set at 2.0. If required, you can 
change this value.

6 In View 3, move the pointer to the apex of the roof on the left building in 
the photograph, using the magnifier as a guide, and enter a data point.

When you have entered the second point, you will notice small squares at 
the respective points in both the raster image and the design geometry, 
joined by a line. These may be hard to see, depending on the colors in the 
raster image. They provide a visual indication of the points that you have 
defined previously.
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Note: If you know the camera focal length used to obtain the original 
photograph, for instance 28mm, you can enter 28 in the Lock Focal 
length field and enable this lock in the Photomatch tool settings. 
MicroStation will attempt the match using this value. If for some reason 
a match cannot be made using the provided focal length, the box will be 
disabled after the match is made, meaning a different focal length had 
to be used.

7 Using the figure below as a guide, snap to point 2 in the design and match 
it to point 2 on the raster image.
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8 Snap to point shown below, in turn, matching them to the equivalent 
points on the raster image.

After placing the third point, notice that the Match button becomes 
active. This indicates that you have placed enough points for the system to 
attempt to match the geometry to the photograph. Adding more points 
adds more accuracy. Three points is almost never enough.

Note: If you select an incorrect point during placement, click Adjust, identify 
the point and relocate it. When you finish adjusting the point, click Add 
to continue adding points.
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9 Snap to another geometry point and add a image point to match, as 
shown below.

10 Click Match.

View 3 updates with the view camera adjusted to show the points as 
defined.

If the geometry still does not match exactly you can add extra points to 
further refine the match. As you do this you can try matching any point in 
the image.

If the camera view is too far removed from the original camera view, you will get 
an error message stating that fact. When this happens, go back to the Define 
Camera tool and try to make the geometry match the image more closely before 
using Photomatch.
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Displaying the Proposed Geometry

Now that you have the design geometry of the existing buildings matching the 
background photograph, you can turn on the proposed design geometry (and 
turn off the existing). The design has been saved with the Solar Lighting values set 
to match the time that the original photograph was taken. This ensures that 
shadows cast by the design elements will look natural.

 Exercise: Display the proposed geometry and render the view

1 Continue in 01_Camera.dgn.

2 In View 3, turn off the level existing house and turn on all other levels.

3 In the Visualization task select Render (Q + 1) with the following tool 
setting:

Render Setup: Draft

Lights: Untitled

Environment: Physical Sky

4 Proposed design is rendered over existing image in Luxology render 
window.

When photo matching you often need to use a photo editing application to get 
the most realistic results. In your image the fence in the foreground may be 
clipped by the deck in the model. You can use an image editing application to copy 
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the fence, and even the shadows, from the original photograph and add these to 
the saved rendering.

Finished image edited with foreground and shadows added

Match points should be spread out both horizontally and vertically. If points are all 
distributed in a narrow horizontal band across the image, then the Photomatch 
tool may be unable to successfully compute the camera settings.

Photomatch using a Civil Engineering example

You can use photomatching for both small and large projects. In the next exercise 
you will be using a civil data set and matching a model of a proposed road 
widening with a photo taken from the existing roadway. 

Date set for this exercise courtesy of South Carolina DOT Roadway Design.

In the previous photomatching exercises a 3D wireframe design was created of 
part of the existing structure. This was used to match the photo to the design 
geometry. In this next exercise the existing condition is represented by several 
surveyed points in the 3D model. These points were surveyed in the field then 
added to the 3D design as weighted points matching the surveyed XYZ 
coordinates.
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 Exercise: Photomatch survey points

1 Continue in 01_Camera.dgn and open the model. 
03_Photomatch_civil.dgn.

This model of terrain geometry has several weighted points, representing 
survey data taking in the field. View 2 is a camera view clearly showing the 
points, which you will use to match corresponding geometry in a 
photograph of the existing site conditions.

2 Check that AccuSnap is enabled.

AccuSnap will make it easy to pick the surveyed points in the design file.

Note: AccuSnap can be toggled on and off using the AccuDraw shortcut J, 
while focus is in the AccuDraw window or the Ctrl+Shift keys.

3 In the Rendering task, select the Photomatch tool (E + 3).

You are prompted to Select View for Photomatch.

4 Enter a data point in View 2 to select this view for photomatch.

The Select Photomatch Image dialog box opens, 

5 In the Workspace\Rendering\images directory, select the file 
phmatch_civil.jpg.

The photo is displayed in View 2 and you can clearly see that the weighted 
blue points representing the bottoms and tops of the power poles are not 
aligned. The weighted green points representing the traffic cones on the 
roadway also are not aligned.

Photomatch image with geometry overlaid
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You are prompted to Enter design file point.

Reference wireframe image and photo showing points to be matched

6 Move your screen pointer to the lower right blue weighted point (point 1 
in the above reference wireframe) and, when AccuSnap snaps to it, accept 
with a data point.

The Photomatch dialog becomes active, displaying a magnified view of the 
photo without the design file geometry making it easier to select the 
appropriate image point.

7 Move the pointer to the bottom of the first power pole on the right of the 
image (point 1 in the reference photograph) and accept with a data point.

Note: The rubber band between the two points depicting where the design file 
point eventually will be aligned to match the photo.

Magnified view matching bottom of power pole location 1.

8 Snap to the blue weighted point located above the previous point (point 
2), and enter a data point.
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9 Using the Photomatch magnified view to guide you, move the pointer to 
the top of the same power pole (point 2 in reference photo) and enter a 
data point.

2nd point top of pole

10 There are two blue points (3 and 4 in the reference wireframe) to the left 
of the previous two. Snap to the top point (3) and accept with a data 
point.

11 Move the pointer to the corresponding image point for the top of this 
power pole and enter a data point.

Top of second pole

12 Snap to the lower point (4) and accept with a data point.
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13 Move the pointer to the bottom of this pole in the image, using the 
magnified window, and enter a data point at the base of the pole on the 
right, as shown below.

Bottom of second pole

14 Snap to the blue point at the left of the view (point 5) and accept with a 
data point.

15 Using the magnified view move the pointer to the top of the 
corresponding pole in the photo and enter a data point.

This pole is located to the right of the building on the left side of the road. 
It is a little difficult to spot but you should be able to make use of the 
Photomatch magnify feature as you move cursor over this area of image.

16 In the Photomatch dialog box, click the Match button.

After matching, traffic cones are not matched to survey data, highlighted area.

The camera location and perspective is modified to achieve a photomatch. 
The 5 points you picked appear to be matched but the cones are a little off. 
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You can fine tune the match by adding these additional survey points and 
matching again.

 Exercise: Fine tuning photomatch by adding additional points

1 Continuing in phmatch_civil.dgn, in the Photomatch tool dialog box, click 
the Add button.

2 Snap to the green point at lower right in the view (point 6) and accept with 
a data point,

3 Move the pointer to the top of the traffic cone on the lower right side of 
photo in the grass area and enter a data point.

Top of traffic cone grass area

Looking at the model, in View 2, notice two more green points in the 
middle of the roadway. Either could be matched to the photo but, for this 
exercise, you will use the lower one of the two (point 7). 

4 Snap to the lower green point (7), in the middle of the roadway, and 
accept with a data point.

There are three cones in the middle of the roadway in the photo you are 
matching. This point corresponds to the top of middle cone. 

5 Using the magnified view to guide you, move the pointer to the top of the 
middle cone and enter a data point.
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Magnified view of cone being matched

6 In the Photomatch tool dialog box, click the Match button to modify the 
camera location and perspective.

Note: Notice that now the cone survey points match those in the photo and 
the image is perfectly matched.

Final Photomatch Render

Now that you have the proposed roadway model matched to the existing photo 
you can render the scene. To make the area more visually appealing, several new 
trees are to be planted along both sides this new stretch of roadway. The trees 
already have been placed on a separate level and are ArchVision RPC files.

 Exercise: Ray tracing final civil photomatch

1 Continue in the model 03_Photomatch_Civil, and make RPC the active 
level.

The RPC files are displayed in all views.

2 Look at the shadow from the power poles in the existing photograph and 
make a mental note of their direction.
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3 Select the Render tool (Q + 1) with the following setting:

Setup: Draft

Lights: Untitled

Environment: Physical Sky

4 Render the contents of View 2.

The view is rendered and you can see the shadows from the RPC trees are 
in a different direction from those of the existing power poles.

It is important to try and match the time of day so the shadows match those in 
the photograph. By looking at the shadows in the photo you can get a rough idea 
of the solar direction and enter this by locking the Solar Direction Vector and 
entering the Azimuth Angle and Altitude Angle.

 Exercise: Modify the Solar lighting to match the photograph

1 Continue in the model 03_Photomatch_Civil and in the Visualization task, 
select the Light Manager tool (W + 1).

2 In the Light Manager dialog set the Solar Position Type to Direction. Set 
the Azimuth Angle and Altitude Angle to the following settings:

Azimuth Angle: 140

Altitude Angle: 45
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3 Render view 2 creating a new solution.
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The view is rendered and the direction of the shadows from the RPC trees now 
more closely match those in the existing photograph.

Final render with RPC trees and people
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Module Overview

Of all of the tools and techniques for achieving truly photo-realistic results, when 
rendering with MicroStation, lighting has the most impact. Without correct 
illumination, a 3D scene will look very flat and two dimensional. Lighting tools in 
MicroStation are presented and proper use is covered to improve your rendering 
results.

MicroStation provides two types of lighting, source and global. Source lighting is 
created via special cells that you place in a model and is covered later in this 
module. Global lighting is available for a DGN file (all models) via settings in the 
Global Lighting dialog box.

Module Prerequisites
• A basic understanding of the essentials of MicroStation V8i

• Knowledge of AccuDraw in 3D

• Basic understanding of Lighting

Module Objectives

After completing this module, you will be able to:

• Understand Model lighting in the design phase of scene creation

• Understand and apply Global lighting techniques to a scene

• Apply and manipulate Source Lights in a scene

• Ability to create volume effects

• Basic use of Advanced Features
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Lighting in General

Lighting is the KEY to photo-realism. THe human eye first detects light versus dark 
in an image and then starts to fill in details. If the lighting is wrong then the brain 
recognizes this and is uncomfortable with this fact, even though the rest of the 
image is correct. So extra time spent on lighting is well worth it.

General Lighting Tips
• Good images tend to have a diversity of light and dark. Consider where you 

want shadows and dark areas when placing lights.

• Many times you want to highlight a specific piece or pieces of geometry in 
your images. Put a spot light behind them so that they are framed in light and 
stand out in the image.

• Study Stage Lighting techniques.

• Use multiple lights of varying intensities to light a single important object. 
Generally, two to four lights is sufficient. Try to keep the angles between the 
lights around 90 degrees.

• If there is no important object to highlight keep the lighting simple, about 
two-four lights.
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• If you have a few lights in your scene and want to know how they affect your 
lighting, give each a unique, bright color so it is easy to spot which light does 
what.

• Soften your Shadows. Crisp, hard shadows are generally unrealistic.

Global Lighting

Global lighting is the shading of a surface that takes into account both direct 
lighting and some indirect lighting, such as reflections and refractions.

The are four types of Global lighting, ambient, flashbulb, solar, and sky dome. The 
following model is displayed with all 4 types of global lighting applied to the 
scene. This model is located in the examples files provided in a MicroStation 
installation at ...\Workspace\Projects\Examples\Plant\Designs\BS1700-S0501-
UnloadingPlatform.dgn

All Global lighting is turned on in this scene

Lighting Tools

The Lights toolbox is located in the Visualization task, (W + 1 or 2). You can also 
access the tools via Tools > Visualization > Lights.
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Light Manager Dialog

Access the Light Manager dialog from the Visualization task, Lights toolbox or 
Settings > Rendering > Light Manager. 

This dialog is used to control light setups for both Global and Source lighting. 

• New light setups can be created, copied and deleted. 

• Source lights can be added or deleted.

• North direction in a scene can be defined.

• You can select all Source lighting in the dialog that is selected in a view.

• When you select a light in the dialog you can highlight the light in the scene.

• You can center the view to the origin of the selected light.
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• IES light sources can display photometric data graphically.

Brightness

This tool controls the brightness of the lighting settings. The 2 main sections are 
Display Brightness which is used for smooth rendering only and the Global 
Illumination Brightness for Luxology rendering
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Display Brightness

There are 2 types of brightness parameters measured in Lumens per square 
meter:

• Brightness Multiplier where all pixels are scaled by a specified factor. 
This factor will be used for next rendering. 

• Adapt to Brightness sets the brightness for the middle of the range for 
next rendering.

There are sliding bars for interactive adjustments. Global Illumination has 3 
sliders. The top for brightness in lumens, the middle for contrast and the bottom 
for the gamma level.

Note: Gamma or Gamma Compression also known as Gamma Encoding, is used to 
compensate for monitors and printers that have less visual response than the 
human eye. Typical gamma values for monitor compensation range from 1.8 to 
2.5 for a CRT and 1.0 for an LCD.

Ambient light

Imaginary light that is presumed to strike every point on a surface with equal 
intensity. Used to approximate the large-scale effects of diffuse inter-reflections, a 
phenomenon not usually accounted for by most lighting methods. The following 
is an example of a scene with only ambient light applied. You can modify the 
intensity, color, and temperature of ambient lighting. Increasing the intensity 
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reduces the depth or contrast of the rendering. Ambient lighting is useful for 
background lighting, illumination of surfaces that do not receive direct lighting. 
No shadows are cast by ambient light.

Left image low settings, right image high ambient setting

Flashbulb

The light from a flashbulb is a point light source originating from the eye-point of 
the rendered view. Intensity, color and temperature can be modified.
Aug-12 111 Lights
Copyright © 2012 Bentley Systems, Incorporated



Global Lighting
Left image is an illustration of the eye-point of view, right image rendering with flashbulb light added

Solar
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Solar light is a simulation of the sun’s illumination. Shadows can be enabled or 
disabled. Solar Positioning has two types:

Direction - created by inputting azimuth and altitude.

Time & Location - created by selecting date, time, city, longitude and latitude or 
KML file.
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Note: When the sun position is below the horizon, then the solar properties section 
of the Light Manager, will display, “No Sun”. Also displayed is the amount of 
Lux, (Lumens per square meter), that is illuminating the scene. 

Note: A sequence of images can be created that will display the sun as it passes 
through the sky. This is accomplished using Utilities > Render > Solar Study.
Lights 114 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Global Lighting
The following images show the effects of solar light at 8: AM, 12:00 PM and 4:00 
PM. The direction of the Sun can be displayed by selecting the Highlight tool in 
the Light Manager dialog and then selecting the Solar name in the Light Name list.

Left to right 8: AM, 12:00 PM and 4:00 PM, note the arrow and sun cone location for each time of day
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Solar light direction can also be placed by selecting a major world city, latitude 
and longitude from Google Earth or a KML file.

Solar direction by City selection

Solar light direction by Google Earth longitude and latitude.

Left image has Google Earth icon highlighted in Light Manager, Right image Google Earth view of Bentley Campus Exton, PA

Solar light shadows can be modified or disabled.

Far left Shadows set to sharp, middle soft very fine and right shadows disabled
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Sky Dome

Sky Dome is a directional light coming from each direction of an imaginary sky 
hemisphere. Enabling shadows causes longer render times. Sky Dome lighting 
provides direct atmospheric lighting from the sky. To provide indirect lighting use 
an luxology environment. When Sky Dome lighting is added to Solar lighting the 
intensity of the light is modified by the angle of the sun and provides a more 
realistic solar study. When cloudiness increases, the direct sunlight decreases but 
the amount of light from the sky increases. With added Sky Dome light, shadows 
are less stark and objects that were hidden in the shadows of a larger object 
become visible.

Sky Dome is sometimes used to bright an area in shadows but when an 
environment is used you can also increase the indirect lighting to achieve the 
same results.

 Exercise: Using Global Lighting tools

1 Continue in 02_Lighting.dgn and open the model 01_Global Lighting.

Several settings have been set for you; let’s review them.

2 Select Render to open the Luxology dialog (Q + 1).

3 Click on the Luxology Environment Settings.
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4 Create a new Environment Setup and name it Global Lighting.

5 Select Sky and set the Sun Size to 4.

6 Open the Light Manager (W + 1).

You can also open this dialog from inside the Luxology dialog.
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7 In the Light Manager, select New, to create a new Light Setup. Name the 
new setup: Global.

8 In the Light Manager, select Solar.

9 In the tool bar across the top select Highlight.

Highlight and Element Section selected.

Warning: You must select the Highlight option in order to see the Sun in the 
final render.

10 Change Temperature to 3200 K Sunrise/Sunset.
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11 Change to the current date.

Click on the current date to set the current date.

12 Set Time to 7:00am

13 Select Position by City and choose Phoenix.

You can also choose a City by getting a Latitude and Longitude from 
Google Earth or a KML file.

14 Leave all other values at default.

Light Setups are automatically saved.

15 In the Luxology dialog, check that your settings are as follows:

Setup: Draft

Lights: Global

Environment: Global Lighting
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16 Select view to render as View 2 and press Render.

17 In the Light Manager, change Solar Location to a Melbourne, Australia and 
re-render. Note changes to shadows and intensity.

18 Use the Define Camera tool and try moving the camera to other positions 
and re-render.
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Photographic Tone Mapping 

If enabled, photographic tone mapping is applied to the image. This setting can 
produce an image that is more like that which your eyes would see. This applies 
particularly to images with a small dynamic range (where the lightest pixel is only 
about 100 times brighter than the darkest). Where the image has a high dynamic 
range, the normal image may be better.

Essentially, tone mapping is mapping the values of the pixels from lux (lumens per 
square meter) into the 0-255 range for graphics displays. No matter what, some 
tone mapping operator is always required. Comparing the two methods:

• Photographic Tone Mapping tries to approximate the human visual system.

• Non-Photographic Tone Mapping tries to spread the brightnesses across the 
range of the display.

In general, Non-Photographic Tone Mapping will always give you a reasonable 
image, but Photographic Tone Mapping should give you a more realistic image but 
can some times make the image appear washed-out.
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Source Lighting

Unlike Global Illumination, which is controlled solely from a dialog, Source lighting 
consists of light sources in the form of special cells that you place in the design. 
This is done with the Define Light tool, which you will look at shortly. First, a brief 
description of source lighting.

Source lighting cells are stored in the cell library lighting.cel, which is accessed 
automatically by the Place Light tool. You do not have to attach this cell library 
before placing light sources. The Place Light tool has various settings for each light 
source type, which you enter prior to placing the light source. The same tool lets 
you modify them, if necessary, at a later date. The cells consist of construction 
class elements and are placed by default on level Default.

Place Light tool

Source lighting provides a choice of 5 lighting types; Point, Spot, Area, Directional 
and Sky Opening. These light sources provide lighting as follows. The following 
scene will be used to provide lighting examples for each source light type.
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Point

Similar to a light globe, point light sources radiate light in all directions, from a 
point light source. 

Point Light Examples

In this example the left image has all source lighting disabled and the right image 
displays only point light sources.

Left image no source lighting and right image Point Lights added.

When placing a point light source you can select a preset source and you should 
get in the habit of creating a name for the light source rather than using the 
default name. You can also select the color or temperature of the light source and 
type of shadow cast. The following image is a close up of the floor lamp with 
construction elements turned on to display the Point Light cell and associated 
Light Manager properties.
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The intent of the following exercise is to create a Light Setup and use it to properly 
render a scene. You will need to place light sources, but the Solar light and some 
source lights have been created for you.

 Exercise: Placing a Point Light Source

1 Continue in 02_Lighting.dgn and open the Model 02_Source Lighting.

2 In View 4 turn off all Levels except for furniture.

3 From the Visualization task select Render (Q + 1).

4 In the Luxology dialog select Light Setups. 

5 In the Light Manager select Solar.

6 Select a location.

7 Set the time of day to a half-hour before sunset.

8 In the Light Manager dialog click on New and name the new Setup: Loft.

You are going to create and place lights for the two table lamps on either 
side of the sofa.

9 In the Light Manager select the Place Light and select Point Light.
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Note that the icon for a new light is different for each type of light.

10 In the Name field enter: Table Lamp 1

11 From the Preset menu select halogen 150W Bulb.

12 Set Cell Size to 0.5.
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13 Select the Center Snap mode and select either of the lamp shades next to 
the couch. Enter a data point to accept.
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14 Select Place Light again and repeat using the same settings for the other 
lamp.

15 Remember to use the Center Snap mode.

16 Render using:

Setup: Draft

Lights: Loft
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Environment: Physical Sky

Spot

Directional light source that behaves similar to a flashlight. Spot Lights have a 
conical beam. This can be defined to taper off to zero at the edge of the beam. 
You can define the Cone Angle for the beam and a Delta Angle through which the 
beam reduces from full intensity to zero. 
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Spot Light Examples

In the following example, the left image displays a wireframe image of spotlight 1 
that was selected with the Element Selection tool. Note the displayed handles 
which allow you to re-target the light or turn light off. The only source lighting in 
this scene is spotlight 1, all other spotlights are turned off.

In the following exercise add spot lights below the staircase.

 Exercise: Place Spot Lights

1 Continue in the same file and model.

2 In the Light Manager select the Loft setup.

3 Select Place Light and choose a Spot Light.

4 Place the spot light below the staircase.
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5 Render using the previous settings.

Area

Created from existing polygons in the design, these light sources are useful for 
simulating fluorescent lighting, for example.

In this example an area light is placed above the stairwell to provide more lighting 
for the stairs. A simple block element is converted to an area light.
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Left image shows placement of block for Area Light conversion and right image is luxology rendering

Directional 

Directional light source that produces parallel light rays throughout the design, 
similar to sunlight. It does not matter where in the model that you place one of 
these light sources, all surfaces that face the direction of a Distant light source are 
illuminated by it.

In the following Directional light example, a directional light is placed such that 
added fill-in light is provided to the dark staircase, railings and back wall.
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Top left directional light selected, top right, scene before directional light and below, directional light on.

Sky Opening

Sky Opening generates more efficient solutions for indoor scenes lit with Solar 
Lighting, Sky Light, or Distant Light sources, through an opening in a wall or 
ceiling. Rather than consider the entire “sky” for calculating the lighting effect, 
only the lighting that is visible through the opening is considered.
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Each source lighting cell that you place in a design can have different settings for 
such things as Intensity and Color. You can specify whether or not they cast 
shadows for the supported rendering modes.

Place Light tool settings

You use the Place Light tool to create and modify light sources in your design. 

Tool settings for the Place Light tool are as follows.

Tool Setting Effect

Preset • Option menu that lets you select from a list of predefined lights.
• Presets available for Point, Spot and Area lights.

Name Text field that lets you define a name for the light source that you are creating. 

Giving light sources unique names helps you identify them if you want to modify them 
in some way, or delete them. Where no name is input, the light is given a default name 
that identifies the type of light source. Where there are other light sources present of 
the same type, with the same name, then the name is incremented. For example, Spot 
Light, Spot Light (1), Spot Light (2), and so on, for Spot Light sources.

Color Opens the color dialog, which is used to specify a color for the light source.

Temperature Option menu that lets you assign a color temperature to the light source.

Intensity Sets the intensity of the light source (default is 1.0) for standard rendering (up to 
Phong). For radiosity, particle tracing, and ray tracing, that use real world lighting, acts 
as a multiplier to the Lumens setting.
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Lumens Sets the light source brightness, for use with ray tracing, radiosity solving, and particle 
tracing. Acts as a multiplier of the light source's Color and Intensity values to simulate 
real world lighting values. This value, when multiplied by the Intensity of the light, 
specifies the overall brightness, in Lumens.

Bulbs Lets you assign multiple bulbs, with the defined settings, to the light source.

Cell Size (Distant, Point, and Spot Lights only) Sets the size of the light cell, in master units.

Bulb Size (Point Lights and Spot Lights only) Sets the size of the light source.

For soft shadows calculations, the ray tracing process assumes a default size of 12 
inches for all point and spot lights. This can cause unnatural lighting in situations where 
light sources are placed within fixtures, where the fixtures are expected to cast 
shadows. For these situations, you can change the default size with this setting.

Shadow If on, the light source can cast shadows in a Phong, or Ray Traced, rendered image, as 
well as with a Radiosity solution, or a Particle Traced image.

In Phong rendered images, only Distant, Area, and Spot lights can cast shadows.

In Ray Traced, Particle Traced, or Radiosity rendered images, all light source types can 
cast shadows.

For Ray Tracing, sharpness of the shadows is controlled by the Shadows setting on the 
Render Mode tab of the Render Settings dialog when mode is set to Ray Trace. If, 
however, Shadows is set to Per Light, then the sharpness of the shadows is controlled by 
the individual light source's Shadow option menu setting. This determines the number 
of samples used to calculate the shadows.

• Sharp — Number of samples — 1
• Soft - Coarse — Number of samples — 16
• Soft - Medium — Number of samples — 64
• Soft - Fine — Number of samples — 160
• Soft - Very Fine — Number of samples — 256
• Custom — Appears when an existing light source has a number of samples that differs 

from those listed above.

IES Data If on, and an IES file has been selected, then IES data is used in the calculation of the 
light from the light source.

Rotation Lets you enter a value to rotate the photometric characteristics for the IES light source.

Cone Angle (Spot Light only) Sets the angle of the beam cone of a spot light source. Used to focus 
the beam.

Delta Angle (Spot Light only) Sets the angle, at the edge of the beam cone, through which a Spot 
Light beam falls from full intensity to zero.

Volume Effects See below

Tool Setting Effect
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Volume Effects

Solar and source lights contains controls for lighting Volume Effects. Available 
settings vary, depending on the type of light source selected. In this scene only 
solar light is used.

Volume lighting depending on the number of lights and the complexity of the 
scene. Volume lights can be very computer intensive and require longer render 
times. 

To help you avoid some frustration when working with volume effects, the first 
step is to get an idea of how the volume effects will appear in your scene, as 
quickly as possible. What you should avoid doing, is trying to render the complete 
scene until you have the volume effects looking decent. 

Scatter Color 

Sets the scatter color value. Clicking the color icon opens a pop-up dialog to set 
the color.
Lights 136 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Source Lighting
Scatter Color can be thought of as the color of the “dust” particles making up the 
volume through which the light is passing.

Scatter Color RGB values set to 94,94,94 (left) and 40,50,156 (right)

Samples 

Controls the accuracy of the volumetric effect underneath shadowing objects. 
Increasing the samples value improves the accuracy.

Samples set to 40 (left) and 200 (right)
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Height

(Applies to Spot Lights, Directional, and Solar lights only) Sets the height in 
working units, of the scattering effect in the volume associated with the light.

Height set to 2 meters (left) and 0.5 meters (right)

Radius 

(Applies to Point, Directional, and Solar lights only) 

For Solar and Directional lights, Radius defines a cylinder radius. This, combined 
with the height, creates the volume through which scattering occurs. 

For point lights, Radius defines the radius of the sphere for the scattering volume.
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Base 

(Applies to Spot lights only) Defines the offset from the spotlight at which the 
scattering can occur.

Base set to 0 meters (left) and 0.2 meters (right)

Scattering 

Controls the amount of light scattering which occurs inside the volume. Higher 
values result in more scattering.

Scattering set to 10% (left) and 80% (right)
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Density 

Sets the density for the volumetric effect. Higher values will make the volume 
thicker and more opaque.

Density set to 10% (left) and 80% (right)

Attenuation 

Controls the amount of attenuation of the effect. A value of 0% gives a natural fall 
off and as the value increases the fall off becomes greater.

Attenuation set to 0% (left) and 50% (right).
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 Exercise: Add a source light to the stairs on the ground floor.

1 From File Open select:

User: examples 

Project: General 

2 Open PhotoRealistic Rendering.dgn and open the Loft model.

3 In view 2 place the Saved View, Stair1.

4 In the Light Manager set the Light Setups to morning early.

5 Open the Light Manager dialog or the Place Light tools and select the 
Place Spotlight tool with the following settings:

Name: Stair light

Preset: halogen 150W Bulb

Cell Size: 1 or any value for you to see construction element

Shadow: enabled and set to Sharp

Cone Angle: 30
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6 Using AccuDraw locate the spot light above the stairs on the ground floor 
and direct the light to the floor as the target.

7 Use the render tool and render the scene.

Note: The scene in this exercise does not use Volume effects to reduce rendering 
time. The following image shows a volume effect placed on the stair spot light.

 Extra Exercise: Volume Lights for Solar and Spot

1 Repeat the process of adding volume light for the Solar light and Spot 
lights in the wall sconce.
Lights 142 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Source Lighting
Volume Lights Tips

After mastering the basics you can see that this is powerful tool for filling in light 
and getting realistic results.

Results below are from a HP Z600, dual quad core Workstation running Windows 
Vista 64-bit.

Tip One

Turn off all the geometry and render the camera view that you intend to use for 
the final render; you can quickly see how the volume effects will look. It is okay to 
have some geometry, for instance in the following example, we are using a bridge 
with 43 lights.

Tip Two

Start with a lower number of samples to speed up the render; you can get a good 
idea with 10 samples and adjust upward for the final render. The image below 
shows a 3 Meter Radius on Volume Effect using 10 Samples (2 seconds to render). 
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The image below shows a 30 Meter Radius 10 Samples (3 seconds to render). It 
uses IES lights. 

The image below shows 7 Seconds to render using a 30 Meter Radius for the 
effect and with the light fixtures visible. 

The noise is a little distracting in the volume effects closest to the camera, so you 
can make the samples higher on the lights those lights. 
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Tip Three

For best rendering performance the Lights in the distance can use lower Samples. 
You can make the lights close to camera have higher samples and then 
progressively lower samples as lights become farther away from the camera.

Add a little scatter color; yellow would work well for street lights.

Tip Four

Turn off volume effects on the lights you cannot see. For example, all the lights 
behind the camera. 

Tip Five

Do not use fine or very fine shadows when you have a lot of lights. It is possible, 
but it could just be a waste of time. 

 Extra Exercise: Use Volume Lights for an Outdoor Scene

1 Open 01_Camera.dgn and go to the Model: 01_Bridge

2 Apply Volume Lights to the bridge lights.

3 Render using night settings.
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Basic Materials
Module Overview

MicroStation’s rendering capabilities let you create photo-realistic images of your 
designs. To create these images, elements in your models need to have materials 
applied to them such that, when rendered, they take on the appearance of the 
real-life object rather than just the color of the design element.

Many of the materials that we have used are made from a raster image that has 
been applied to elements in the design in much the way that wallpaper is applied 
to a wall. Where a surface’s area is larger than that of the image, the image can be 
stretched, repeated, or tiled, to fill the surface.

Materials can be images from a standard raster source like TIF or JPG of wood, 
metal, marble, glass, etc. Materials can also be created by software, such as Fur 
and Displacement maps.

Module Prerequisites
• Knowledge of Camera and AccuDraw in 3D

• Knowledge of Lighting

• Knowledge of basic rendering capabilities

Module Objectives

After completing this module, you will be able to:

• Use Assign Materials tool

• Use Attach Materials tool

• Create a Material
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• Create a Multi-Layered Material

• Be able to use Basic Material Edit options

• Dynamically Adjust Maps

• Project Materials

Materials Introduction

By default, Luxology rendering assumes that each design file surface is made of a 
material with a smooth shiny surface, such as plastic. Material definitions let you 
specify that an element is water or wood or brickwork. When rendered, instead of 
seeing the plastic element, you see the specified material. Each material 
definition can include a pattern map and/or a bump map, as well as other settings 
determining the finish and transparency/translucency of the material plus much 
more. Pattern maps and bump maps are image files that are applied to surfaces 
during the rendering process.

Materials Task

The Materials task is a available in 3D models as part of the Visualization task.

Material Definitions

Material definitions are attributes related to color, texture, opacity 
(transparency), and many more options in the material definition dialog about the 
usage of a material. Material definitions are created and stored in material 
palettes. For external materials, these are palette (.pal) files and always must be 
present when applying materials, or rendering. For local materials, the external 
palette file is required only the first time that you access a material. By default, it 
is then stored in the DGN file. 

So Material Tables and Palettes are still used but are separated into two distinct 
categories — local and external. You must decide which to use or if you will use a 
combination.
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Local Materials

By default, materials are local and saved in palettes with the DGN file. You can set 
the variable, MS_LOCAL_MATERIALS = 1, either in your UCF or PCF. This variable 
will store material definitions in the DGN file and not in external files.

Hint: It is strongly advised that you use DGNLIBs and DGNs to store your materials 
instead of external files.

Where required, you still can convert or export the materials and palettes to 
external files.

Material palettes can be used from any DGN or DGN Library. You can review: 
C:\Documents and Settings\All Users\Application 
Data\Bentley\MicroStation\WorkSpace\System\dgnlib\

for more information on what is available.

When you select Palette > Open from the Material Editor, you can select a DGN 
file to display and import the palettes contained within it.

External Materials

External materials require an external material assignment table (.mat) and 
material palette (.pal) files to be present during rendering. Options in the Material 
Editor dialog's Table menu let you convert or export local materials to external 
files.

Where required, you can access local palettes and their materials that are stored 
in other DGN files.

Material tables

When you assign materials from a palette file to an element in a design, the 
assignment is stored in a material table. By default, material tables are given the 
same name as the design file but have a .mat suffix. Also, by default, material 
tables are saved in the same folder as the design file. You can save them with 
another name and in another folder, if you wish.

Palette Files

Palette files (.pal) are where material definitions are stored.
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Sample Materials

Many sample material definitions are supplied with MicroStation in 
Bentley_Materials.dgnlib. If you do not plan to create your own material 
definitions, but want to apply existing material definitions to elements, see the 
Apply Material tool.

Pattern maps

A pattern map is an image file that is applied to an element. You can think of this 
in terms of wall-papering a wall. When you render an element that has a pattern 
map applied to it, instead of seeing the element (wall) you see the pattern map 
(wall-paper). MicroStation provides a number of image files, in JPG and TIF 
format, that can be used for pattern maps. These are stored in the 
…\Workspace\system\materials\pattern folder. 

You can use your own image files as pattern maps or explore the other sub-folders 
in ...\materials\

Bump maps

Like pattern maps, a bump map is an image file that is applied to an element. 
Where it differs from a pattern map is that a bump map applies roughness or 
texture to a rendered surface. While it is not mandatory for bump map images to 
be grey-scale, quite often they are. MicroStation uses the contrast in the bump 
map image to calculate texture, or bumps, in the rendered image. As part of the 
material definition, you can vary the height of these bumps. This lets you use the 
same bump map image file, for example, to create cast metal from very rough-
cast through to nearly smooth. An alternate to Bump Maps are Displacement 
Maps.

Other Images

There are additional images that ship with MIcroStation V8i. These are for 
Backgrounds, Objects, Signs and others. These are found in:

…\Workspace\System\materials\

Hint: Using Element Selection is a quick way to find and change material assignments 
and attachments.
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Materials Characteristics for V8i

Materials tools include changes to the default method of storing materials and 
multi-layer material capability.

• By default, all palettes and their materials now are stored locally in the DGN. 
Where required, you still can convert or export the materials and palettes to 
external files.

• You can access material palettes from any DGN or DGN Library file. When you 
select Palette > Open from the Material Editor, you can select a DGN file to 
display the palettes contained within it.

• New mapping options, let you apply an image, gradient, procedure, or 
Operation (Tint or Gamma) to the Color, Translucency, Specular, Reflect, 
Finish, Opacity, and Bump channels. As well, each channel can be multi-
layered. The Material Editor lets you access the mapping option via icons for 
each channel.

• You can use the X, Y, (and Z for 3D procedures) lock setting in the Units 
definition for a material map to lock the image into the aspect ratio of the 
original image. When the lock is enabled, any changes to the X, Y, or Z settings 
automatically is reflected in changes to the other settings to maintain the 
aspect ratio of the original image.

Working with Materials

There four basic ways of getting a material on an element.

1 Assign the material to the element color/level combination.

2 Attach the material to a specific element or surface on that element. It is 
important to note that ATTACH overrides ASSIGN.

3 Apply a material as a Level attribute (you can have separate ByLevel and 
Override materials) in the Level Manager, so any object on that level is 
assigned that material.

4 Assign a material through an Element Template.
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The Assign tool is the most commonly used tool as it allows for the application of 
materials to a large number of elements without having to select them 
individually. 

Warning: When using the Assign tool, the element must use an Indexed color. If the element 
uses a RGB (True) color or a Color Book color (e.g. Pantone) then it cannot accept 
an Assignment and you must choose another method like Attach.

In addition, if you use Bentley Architecture products you can store the material in 
the Part/Family definition. However, Bentley Architecture Parts require that the 
external .mat and .pal files exist. BA Parts cannot read DGNLIBs at this time.

Materials priority

When attaching/assigning materials to elements, solids, or faces of solids, the 
priority that applies to the material assignments, highest to lowest, is as follows:

1 Material applied by a level override.

2 Material attached to the face of an element.

3 Material attached to an entire element (or by element template).

4 Material assigned by level and color (if color is ByLevel then the 
assignment is by level and the color of the level).

5 Material attached to the level (this is the ByLevel level Attachment - the 
Material column of the Level Manager).
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The Apply Material Tool

When you select the Apply Material tool, the Apply Material tool settings opens. 
From this dialog, you can load palette files, apply materials or open the Define 
Materials dialog.

From left to right, the icons across the top of the Apply Material tool settings 
dialog let you select from:

• Assign by Level/Color — to attach a material to elements of a particular 
color(s) on a particular level(s) in the model. You cannot assign a material to a 
RGB colored element. It must be an indexed color. RGB color functionality for 
Material Assignments is coming in a future release of MicroStation.

• Remove Assignment — to remove an existing level/color material assignment 
from elements in the model.

• Attach — to “physically” attach a material definition to an element, or a face 
of a solid or surface, in the model. This setting takes precedence over level/
color assignments.

• Remove Attachment — remove a material attachment from an element or the 
face of a solid or surface in the model.

• Query — to check for a material assignment to an element in the model. With 
AccuSnap active, you simply hover the pointer over the element being 
queried, and a tool tip displays the assignment or attachment information.

You can double-click on the Preview window to open the Material Editor. You can 
also right-click on the Preview window to change the display to another piece of 
geometry including geometry in the model.

The option lists keeps track of the Material Table, Palette and specific material 
and allows you to change them.
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Working with Materials

To apply materials you can Assign them to a Level and Color combination either 
by using a table or selecting an element.

 Exercise: Assigning a Material

1 From File Open set:

User: untitled

Project: Rendering

2 Open 03_Materials.dgn.

In the 01_Materials model you have six spheres above a base object. Each 
sphere is a different color and is on a different level, except the magenta 
spheres which are the same color and level.

3 Open Level Manager and examine the Level structure.

4 Note that Material: cool_home_floor is assigned to the level Default.

5 From the Visualization task select Apply Material (A + 2).

6 In the tool settings, select Assign Material.

7 In the tool settings, click on the Open Palette icon next to the Palette 
option list.
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8 From the dialog select Luxology_Presets.pal [Bentley_Materials.dgnlib].

You now have access to all materials in the Luxology_Presets palette

9 You have two choices for viewing materials: a list or thumbnails.

You can also change between palettes here by clicking on the Palette 
options list.

10 From the Materials option list select Fabric - Velvet and click on the 
magenta sphere in any view, though it is easier in the Top view.

11 One more data point is required to accept, so click in empty space to 
accept the assignment.
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12 Put your pointer over the magenta sphere and notice that in its balloon 
information, it shows the assignment.

Since all four of the magenta spheres are on level Render 2 and are color 5 
all four will have the same material assignment.

13 In the tool settings, change the Material to Glass_Clear_LC and select the 
orange sphere and enter a data point to accept.

Note how it disappears from View 2, as glass is transparent.

14 Choose another material for the remain sphere and Assign that material.

15 From the Visualization task, select Render (Q + 1), or select it from your 
View tool box in the view.

Since Render is considered a View Control it is also available from that tool 
box as (4 + I).

16 Select Begin Luxology Render.

Completed rendering

The four magenta spheres are shown as Red Velvet since one had the material 
assigned and the other three shared the same level/color combination as the first. 
Engine Nozzle was used on the cyan sphere.
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 Exercise: Material Attachment

1 Continue in the same file and model.

2 Continue in the Attach Material (A + 2) command and select Attach.

3 From the Luxology Presets palette, select the Material: Glass 
BlueGroup_LC and select the magenta sphere in the first row on the right.

4 Render View 2 again in the Luxology dialog.

Note the distortions seen in the sphere, these are caused by refraction and 
referred to as caustics.

Next you will change one of the faces of the solid that the spheres are floating 
above.

 Exercise: Material Attachment to faces of solids

1 Continue in the same file and model.

2 Open Saved Views from the Primary tool box.

3 Apply the Saved View Materials Attach to View 2.
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4 Continue in the Attach Material (A + 2) command and select Attach.

5 Select Open Palette and select landscape.pal [Bentley_Materials.dgnlib]

6 Select the Material: Grass Lawn Mowed

7 Select the solid in the top view and move your pointer into the middle of 
the face at the bottom. It should highlight. Enter a data point after it 
highlights.

8 Hold the Ctrl key down and move the pointer to the right and select the 
face on the right edge.

9 Enter one more data point to accept the attachment.

10 From the Visualization task, select Render (Q + 1).

Data point

Ctrl + data point
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11 In the Luxology dialog select Begin Luxology Render.

 Exercise: Using Materials

1 Open the Model 02_Materials.

Some materials have already been applied.

2 In the Visualization task select Render (Q + 1).

3 Click on the Material icon in the Luxology dialog.

This opens the Material Editor.

4 Select the carpets&fabric.pal [Bentley_Materials.dgnlib].
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You now have access to all materials in that palette.

5 Right click on black_leather and select Assign.

6 Left click once on the cushion of the chair and left click again on nothing 
(empty space).

The second left click is to Accept the assignment of the material.

7 In the carpet&fabric.pal [Bentley_Materials.dgnlib] palette, select the 
material: carpet_52

8 Right-click and Assign carpet_52 to the cyan block representing the floor 
carpet underneath the chair.

9 From the metals.pal [Bentley_Materials.dgnlib] palette select the 
material: chrome-reflective and assign to a leg of the chair.

10 From the glass & plastic.pal [Bentley_Materials.dgnlib] palette select the 
material: green glass refract and assign to the vase on the table.

11 From the glass & plastic.pal [Bentley_Materials.dgnlib] palette select the 
material: deep blue glass refract and assign to the glass on the table.

12 Select the Render tool.

13 In the Luxology dialog, select Luxology Render Settings and choose Draft.
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14 Render the model by selecting Render in the Luxology dialog.

15 Explore other materials (for example, Fabric- Velvet from 
Luxology_Presets) and try them out. You can Remove Assignment, by 
using the right-click menu on a specific material.

16 Examine other materials in use. Change and re-render the views.

Material Editing

You can easily create your own materials or change the existing materials 
properties with the Material Editor. Learning proper use of the Material Editor is 
critical to success with Rendering.
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There are two interfaces: Basic and Advanced.which can be changed from inside 
the Material Editor dialog, Settings > Advanced Mode.

Basic Interface 

In the Preview area preview refresh option button has been added. This has 2 
available options: Automatic which will update the preview whenever material 
setting is changed and Manual where the preview image will only update when 
the preview is clicked on.

The recommendation is to use Manual.
Basic Materials 162 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



The Apply Material Tool
Advanced Interface Mode
Aug-12 163 Basic Materials
Copyright © 2012 Bentley Systems, Incorporated



The Apply Material Tool
Both modes have balloon help so that you can put your pointer on top of a 
feature and get an explanation of that feature.

In either mode you can quickly figure the basic ideas behind each setting.

Controlling the Preview

MicroStation V8i has expanded the naming convention for saved views with 
models to be used for material examples. 

Examples for a palette are contained in Saved Views with names in the form of 
$preview$paletteName$exampleName in Bentley_Materials.dgnlib.
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 Exercise: Preview Control Overview

1 Open ...\Workspace\System\Materials\Bentley_Materials.dgnlib.

2 Open Saved Views and take note of specific syntax for the names.

3 Open the Models dialog and open each model, taking note of geometry 
used to create Previews.

The general form is:

$preview$paletteName$exampleName

If exampleName is omitted, it will appear in the example list as “Example”. For a 
palette named “Woods”, the following syntaxes are all equivalent:

$preview$Woods

$preview$Woods$

$preview$Woods$Example

To use multiple examples for a palette, any example after the first would need a 
unique number. For example
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$preview$Woods$Block

$preview$Woods$1Bench

$preview$Woods$2Door

To provide examples that would be used for all palettes, simply omit the palette 
name. For example:

$preview$ $100Torus

$preview$ $101Window

Warning: Bentley reserves the right to create examples with numbers up to 99, therefore it is 
recommend that any user-created examples use unique number identifiers 
between 100 and 999.

You can use your own personal DGNLIB’s or project or organization wide 
DGNLIB’s.

Material Definition Basics

1 - Light Source

2 - Diffuse (percentage of light that is randomly dispersed in all directions). 
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3 — Specular (percentage of light reflected in the mirror direction) and Reflect 
(percentage of light that is visible in the mirror direction).

4 — Surface Normal

5 — Refract (angle that light “bends” as it passes through an object).

6 — Translucent (percentage of light that passes through an object and then is 
dispersed randomly in all directions on the back side of the object).

7 — Transparent (percentage of light that passes through the object).

8 — Finish (roughness of the surface, which controls the falloff of highlight on a 
surface)

In reality, all objects absorb some amount of light. That is, not all the light that 
strikes an object is reflected or transmitted. Similarly, when you define materials 
in your models, they should not be greater than 100% efficient. This is important, 
in particular, for materials that are to be used in photo-realistic images. For these 
materials, the following formula should be used:

Efficiency = Diffuse + Translucency + Specular + (100 - Opacity) <= 100

Using the Efficiency lock, in the Material Editor's advanced mode, you can select 
an Efficiency value, which is maintained as you modify the above settings. That is, 
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if you modify a setting for Diffuse, Translucency, Specular, or Opacity, changes are 
made also to the remaining three settings to maintain the Efficiency setting.

Material Hints

Many settings are seldom changed while others can be changed all the time. 
These are some useful hints for settings that are most commonly used in a 
material definition.

A helpful tool is the Filters which allow you to filter materials based on Used and 
Unused Assignments and Attachments

When creating new materials it is important to have a known starting point. 
Hence, you should create a Starting Point material in your own DGNLIB’s.
Basic Materials 168 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



The Apply Material Tool
When the rendering process comes across a material definition, the four 
components — Diffuse, Specular, and Opacity, and Glow, all have an effect on the 
outcome.

Diffuse 

The material's Base Color scaled by Diffuse, represents the percent of light (in 
each color) reflected by each light. This diffuse color determines how bright the 
material appears when illuminated, and how much light is reflected onto other 
surfaces. 

For materials that are pattern-mapped, Color is first blended with the pattern 
map, and then Diffuse is applied.

Specular

The Specular Color, scaled by Specular, represents the percent of light (in each 
color) that is reflected off a surface as a specular highlight, where you can “see” a 
reflection of each light source in the surface. When additionally scaled by Reflect, 
this yields the percent of light (in each color) that is seen in a reflection of an 
object. This value also represents the amount of light that will be reflected in the 
mirror direction onto other surfaces, accounting for caustics.

Opacity

The Specular Color scaled by Opacity, represents the percent of light (in each 
color) that passes through a surface. Note that this means that a material with a 
Specular Color of black will never transmit any light, even if Opacity is set at zero. 
This applies when the material is casting shadows and when objects are seen 
through the material. 

Glow

The Glow setting is used to create special effects such as neon lights. The value for 
Glow adds to the overall reflectance of the material and is independent of the 
amount of incoming light.

Efficiency

Efficiency is the amount of total light that is reflected or transmitted by the 
material.
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For physically correct material definitions, it is important that the Efficiency does 
not exceed 100%. In the real-world, materials generally range in efficiency from 
30% to 70%.

Reflectivity and Transparency

1 Unless a material is meant to be reflective or transparent, its Reflect 
setting should be set to 0 and Opacity set to 100. In Basic mode, use Dull/
Shiny and Opaque/Clear.

2 If Transparency is off, in the Luxology Render Settings, transparent 
elements are rendered opaquely in that view.
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3 Reflections and transparency are tinted by the Specular (highlight) Color 
(only visible in Advanced mode) of the material. 

4 The amount of reflectivity also is modified by the Specular material 
property. For example, if Reflect is set to 80% and Specular is set to 40%, 
the material is only 32% reflective, as the two fields are multiplied 
together. The reflectivity is further modified by the Specular Color. The 
RGB values of the reflections are the products of the above (32% 
reflective) and then multiplied by the respective RGB values (between 0 
and 255) of the Specular Color. The same holds true for transparency 
(controlled by the Opacity setting).

5 Where there are no environment maps defined, a reflective object that 
does not see another object in its reflection will reflect the background 
color, as defined in the MicroStation color table (Settings > Color Table). 
Thus, reflective objects will appear brighter when rendered with a white 
background than they would with a black background. Where 
environment maps are defined, and Environment Mapping is enabled, 
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then these will be reflected in place of the background color. Any 
background image that may be defined for a view, however, is not 
reflected. 

6 Material definitions for older existing DGN files may have Reflect set to a 
value other than zero. This means that more objects may be reflective 
than intended, in a model, which can slow down rendering unnecessarily. 
Use the Material Editor dialog to ensure that the reflectivity of only those 
objects that are intended to be reflective is set to a value greater than 
zero.

Transparent Surfaces and Refraction

Refraction is the bending of light as it passes from one medium to another, for 
example, light passing from air to water.

When rendering a transparent surface (as opposed to a solid), if the element is 
defined in a clockwise order, transmitted rays bend as if they were leaving the 
element, as opposed to entering. 

Other options are to use the reciprocal of the refraction value for the element's 
material, or to reverse the surface normals using the Change Surface Normal tool 
in the Modify Surfaces toolbox.

Glass

To achieve a realistic glass surface, the Diffuse Color (color of light reflected in all 
directions) value should be relatively low (for example, zero to 5). Clear glass 
actually is colorless, that is, its diffuse color is black, not white. Its Specular Color 
(the color of light that is reflected directly back to the eye) is white. Tinted glass 
can be obtained by modifying the Specular Color.

The following example of photorealistic glass material has parameters set as 
follows:

Base color is black (0,0,0) for all glass material.

Specular color white (255,255,255), value 0 for the table top and colors pink and 
blue for vase and glass with specular values of 1 for each.
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Opacity for vase and glass is 2 and table top is 40.

 Exercise: Editing a Material

1 Continue in the same file and model.

2 From the Visualization task select Define Materials (A + 1).

You can also open the editor from the Luxology dialog and by double-
clicking on the material preview window in the Apply Materials tool 
settings.

3 Work in the Basic mode.

4 Expand the carpet&fabric.pal [Bentley_material.dgnlib] and select: 
black_leather.
Aug-12 173 Basic Materials
Copyright © 2012 Bentley Systems, Incorporated



The Apply Material Tool
5 Click on Color to change the color.

6 Change the RGB values to:

Red: 136

Green: 82

Blue: 41

A medium brown color. You can also select a color from a Color Book.
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7 Render View 2.

Black Leather edited to Brown Leather

8 Experiment with other settings and re-render to see results.

You can now create any color of leather and use it. You can save new definitions or 
simply keep one definition and change the color as you need.

More advanced features of the Material Editor will be covered in the next module.

 Exercise: Creating a New Material

1 Continue in the same file and model.

2 From the Material Editor select menu item Palette > New.

3 Name the new palette: Local.

4 Highlight Local and select menu item Material > New or right-click on Local 
and select New Material from the right-click menu.

5 Name the new material Suede.
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6 Click on the Pattern icon to add a pattern image.

7 From the Open Image File dialog, browse to 
...\Workspace\Projects\Rendering\image and select the file 
microfiber_Suede_beige.jpg.
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The following dialog opens:

8 In the Pattern for Suede dialog confirm:

Units: Surface

Size X: 1.000

Size Y: 1.000

Mapping: Parametric

9 Close the Pattern for Suede dialog.

10 Remove the black_leather pattern on the chair and Assign the Suede 
material to the chair.

11 Select Render (Q + 1).
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12 Re-render in the Luxology with the same settings.

13 Explore other options in the Material Editor like Dark/Bright, Dull/Shiny, 
etc.

14 If time permits use the Render Setting: Caustics

15 Keep the file open for the next exercise.

Multi-Layered Materials

You can create materials that consist of multiple layers of pattern maps, bump 
maps, procedures, gradients, and/or operations (tint or gamma setting). For 
example, showing tire tracks on a road or graffiti on a wall or dirt on a surface.

New mapping options let you apply an image, gradient, procedure, or Operation 
(Tint or Gamma) to the Color, Translucency, Specular, Reflect, Finish, Opacity, and 
Bump channels. As well, each channel can be multi-layered. The Material Editor 
lets you access the mapping option via icons for each channel.

You can define the way that the pattern/bump maps are blended and you can 
assign a value for opacity, to allow one map to be seen through another.

Adding layers of pattern maps, lets you create more complex materials. For 
example, you can create a brick wall that includes 1 or more signs, or have a 
material with partial opacity.
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Blend modes for Materials

You can have 4 blend modes: Normal, Add, Subtract and Alpha.

The formulas for calculating the resulting pixel for each blend option is based on 
the following variables:

pA - Image pixel value of the selected layer.

pO - Opacity of the selected layer (varies from 0 to 1).

pB - Image pixel value for the combined layers below the selected layer.

pR - Resultant (blended) pixel.

pX - (For Alpha only) Pixel value for the blend between the 2 images.

You will not have to do calculations in order to use this tool. Most users simply try 
different combinations to see the results.

Normal

Pixels are blended according to the formula:

pR = pO * pA + (1.0 - pO) * pB

Examples:

If the opacity of the selected layer is 100% (that is, pO = 1.0) then the pixels of 
image A completely occlude those of the layers below.

If the opacity of the selected layer is 70% (that is, pO = 0.7) then the resultant 
pixel color is 70% of image A combined with 30% of image B (the combined image 
of the layers below).

Add

Pixels are blended according to the formula:

pR = pO * pA + pB

Example:
Aug-12 179 Basic Materials
Copyright © 2012 Bentley Systems, Incorporated



Multi-Layered Materials
If A has 100% opacity, with RGB values 20, 40, 60

B has RGB values of 100,100,100

Then the RGB values for the resulting pixel is 120, 140, 160 - a straight addition. 

Subtract

Pixels are blended according to the formula:

pR = pO * pA - pB

Example:

If A has 100% opacity, with RGB values 100, 100,100

B has RGB values of 20, 40, 60.

Then the RGB values for the resulting pixel is 80, 60, 40 - a straight subtraction. 
Negative values are not allowed. If the subtraction results in a negative value then 
a value of zero is substituted.

Alpha

Pixels are blended according to the formula:

pR = pO * pA * pX + (1.0 - pO) * (1.0 - pX) * pB

In the list box, the Alpha image is on the same row as the selected layer. pB is the 
composite of all the images in the background node and pA is the composite of all 
the images below, but not in the background node.You can add layers to your 
material definitions, with various blend modes. The layers can be toggled as 
required.

Warning: Multi-layered materials are not backward compatible with MicroStation V8 XM 
Edition v8.9.2 and earlier.

 Exercise: Creating and using Multi-Layered Materials

1 Continuing in Materials.dgn, in the model 02_Materials, from the 
Visualization task open the Materials Editor (A + 1).

2 Open the Palette carpets&fabric.pal [Bentley_Materials.dgnlib].
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3 Expand the node on the left pane and highlight the material carpet_52 
and click the Pattern Map icon.
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4 From the top left click New Layer and select Fabric42.jpg.

The Blend, Value, and Display column values for the bottom layer in the 
list are not editable and appear dimmed.
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5 Set the Opacity Value to 50%, by clicking on the number in the Value 
column and moving the slider bar.
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6 For Fabric42.jpg change the Blend to Add by clicking on the text Normal in 
the Blend column.

7 Confirm and/or set the following:

Units: Meters

Size X: 1.00

Proportional Lock: Enabled

Mapping: Parametric
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8 In View 2 zoom in on the right side of front table and Render using Draft 
Luxology Render Setup. You can keep the other dialogs open.

9 Repeat the process except Subtract instead of Add the material. Re-render 
to see results.

10 If time permits explore other Layer options.
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Other Layer Options

Besides an Image layer you can also create a new:

• Gradient - Apply a gradient as a material map, either individually or as part of 
a multi-layer material

• Procedure - Use a procedural material as a layer

• Group - Adds a group layer to the layers list box. Grouping allows operations 
to be applied to the whole group and is not necessary.

• Operator - There are two types of operations: 

• Tint - Lets you define a color.
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• Gamma - Lets you define whiteness of image.

Left image is Tint and right is Gamma with a value of 1

You can Cut, Copy, Paste and Delete layers with the icons at the top of the dialog.

You can also add layers for other maps being used for that material, such as multi-
layer Bump maps.
Aug-12 187 Basic Materials
Copyright © 2012 Bentley Systems, Incorporated



Dynamically Adjust Map
Dynamically Adjust Map

The Adjust Map tool is used to interactively adjust the scale, position and rotation 
of any pattern or bump map. For specular, translucency, glow and other maps you 
can adjust the amount of each channel, i.e. amount of transluceny.

Icons across the top of the tool settings window let you select the adjustment 
mode: Move, Scale or Rotate. The icon to the right of the Map option opens the 
Map Editor dialog.

This tool can be selected from either the Materials toolbox, or from the Map 
Editor dialog. If you select it from the:

• Materials toolbox — any element with a mapped material can be selected.

• Map Editor dialog — only elements using the current material can be selected.

You also have the choice of editing a specific layer in the material definition.

This tool requires good snapping and AccuDraw skills. Move, Scale and Rotate 
behave as they do with regular elements.

In the following exercise, you will adjust the scale of the fabric image in the 
carpet.

 Exercise: Dynamically Adjust Map

1 Continue in the same file and model.

2 From the Visualization task, select Dynamically Adjust Map (A + 3).

3 In the tool settings select Scale.

Note that other settings are grayed out.

4 In the Top view select the cyan block representing the carpet.
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Now the other tool settings highlight. You can change the Layer and Scale 
type.

5 In the tool settings set:

Type: Pattern

Layer: Fabric42

Method: 3 Points

Proportional Lock: Enabled

6 In the Top view snap to the lower left vertex of the cyan block and enter a 
data point to select the element.

7 Snap to the right lower vertex and enter a data point to select point to 
scale about.
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8 Snap to the one-third point on the bottom edge and enter a data point to 
select a reference point.

9 Move cursor right to decrease the size of the diamond shape in the carpet.

10 Select Render (Q + 1).
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11 Render using the same settings.

12 Note the smaller diamond pattern in the carpet.

13 If time permits explore Rotate and Move.
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Material Projections

Projection modes are assigned to elements, rather than the material. This lets you 
use the same material with various projection modes depending on the 
geometry.

Control projection modes using the Material Projection task.

The tools from left to right are:

• Map Projection

• Edit Projection

• Copy Projection

• Create Projection Group

• Delete Projection
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Projection modes for materials

Several projection modes are available:

Directional Drape

Mapping is applied relative to the direction specified by the Orientation setting

Cubic

Mapping is applied in a cubic fashion relative to the geometry.

Spherical

Mapping is applied in a spherical fashion relative to the geometry.

Cylindrical

Mapping is applied in a cylindrical fashion relative to the geometry.

Warning: Material projection modes are not backward-compatible with MicroStation V8 XM 
Edition v8.9.2 and earlier.

Tools for controlling Material Projections

The following exercise applies projections to simple geometry to see how 
projections work.

 Exercise: Using Projections

1 Continue in Materials.dgn, and open the model named 04_Material 
Projection.

All elements are on the same level and are the same color.

2 From blocks&bricks.pal, use Apply Material (A + 2) to assign the material 
brick back alley to the geometry.

3 Zoom in on the sphere

4 Render with Default render settings to see the results. 
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5 Take note of the sphere.

6 Select Attach Projection (S + 4) with the following tool setting:

Attach To: Element

Method: Spherical 

7 Enter a data point on the sphere.

8 Render to see result.

Only the mapping on the sphere changed.

9 Repeat the before and after with the cylinder with the Cylindrical map 
projection.
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10 Try a spherical projection to the slab.

Elevation Drape

The ability to drape an aerial or satellite photograph on a Digital Terrain Model 
(DTM) is now available in MicroStation through its materials.

The draping function is based on a MicroStation rendering feature called 
Procedural Materials, which allows the application of a specific behavior to the 
raster image. This image can be draped over a Digital Terrain Model (DTM) or any 
3D object using the DCDRAPE.PMA Procedural Material. In the case of aerial 
photos or satellite images, the DTM should be used. By using the draping feature 
in the Raster Manager you can seamlessly integrate any image in the rendering 
process with 3D elements. It also supports lighting effects, shadows, fog effects, 
fly through, animations, etc. Bentley Descartes is no longer required to drape 
rasters over digital elevation models. 
Aug-12 195 Basic Materials
Copyright © 2012 Bentley Systems, Incorporated



Elevation Drape
The Challenge

Raster images are 2D with an X by Y pixel matrix. Raster Manager displays 2D 
images in the TOP Views with a rotation around the Z-axis. The image draping 
function allows you to drape 2D images over a terrain, which is represented by a 
3D surface in MicroStation.

Try to keep your image sizes below 5000 x 5000 pixels, however, with more 
memory you can work with larger images.

 How To Do an Elevation Drape

1 Begin by launching MicroStation and select the DGN file representing the 
3D model used for the draping. 

2 Use the Raster Manager to place the image correctly. Using 
GeoCoordination of your geometry and the image. Correctly placing and 
scaling the image is critical.

3 Create the palette that will contain your materials for the draping and 
rendered objects. As a rule of thumb, custom palettes are the preferred 
way of creating sets of materials for a specific project. 

4 Once the palette is created, add the Drape material to it by creating a new 
material and selecting the dcdrape.pma file as the Pattern Map.

5 The next step is to apply the material to a design element. In this case, the 
3D model that will be used to project the image and drape it.

6 The last step is to view the draping. Using the Render tool, enter a data 
point in the view displaying the images where the draping is intended. 
Usually, a camera view. This allows a better view angle in order to visualize 
the 3D effects on the draped image.

The dcdrape.pma file is found in:

C:\Program Files\Bentley\MicroStation V8i (SELECTseries)\MicroStation\ 
mdlsys\textures\
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The following exercise has both aerial imagery and 3D DTM geometry.

 Exercise: Doing an Elevation Drape

1 Continue in 03_Materials and open the model: 05_Elevation Drape.

2 Open Raster Manager from the Primary tool box or File > Raster Manager.

3 Enable Draping by clicking in that column.

You can turn columns on and off by right-clicking on any column title.
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4 In the Visualization task select Define Materials (A + 1).

5 Highlight the local palette and from the menu select Material > New.

6 Name the new material: Drape.

7 Click on the Pattern Map icon to select a material.

8 Change FIles of Type to Procedural Application FIles (*.pma)

9 Navigate to: C:\Program Files\Bentley\MicroStation V8i 
(SELECTseries)\MicroStation\mdlsys\textures\
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10 Select dcdrape.pma.

11 Close the Pattern for Drape dialog.

12 In View 2 change your Display Style to Smooth. Note how the DTM 
renders in blue.

13 Return your Display to Wireframe.

14 In the Materials Editor, right click on Drape and select Assign and select 
any part of the blue DTM. Accept the assignment.

15 In View 2 change your Display Style to Smooth. Note how the DTM 
renders with the aerial map.

16 You can now use this setup with the Luxology engine.
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Advanced Materials
Module Overview

There are many advanced materials options. These include additional features, 
mapping methods, and settings.

Module Prerequisites
• Basic knowledge of Materials

• Knowledge of Camera and AccuDraw in 3D

• Knowledge of Lighting

• Knowledge of basic rendering capabilities

Module Objectives

After completing this module, you will be able to:

• Use Material Maps

• Use Fur Materials

• Use Displacement Materials

• Use Anisotropic Materials

• Apply Material Projection tools

• Using RPC Cells
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Advance Materials Introduction

The Materials Editor in MicroStation is robust. It is possible to achieve almost any 
type of materials required. New options allow for 3D materials created by the 
software and enhanced by images, allowing for realistic Fur, Grass, Fabric, Stone, 
and much more.

Additional Map Types for Luxology

Luxology does provide for additional Material options. These options are an effect 
on the underlying materials.

Clear Coat 

The clear coat map changes the perceived thickness of the clear coat lacquer 
effect. 
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Diffuse 

A diffuse map can be used in conjunction with a pattern map to give more 
contrast to the diffuse reflection.

Glow 

The pixels in a glow map specify the fraction of glow emitted by the surface at 
that point up to 100%.

Opacity 

Maps for Opacity vary the transparency across the material with the darker parts 
of the map being more transparent.
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Specular Color 

If a surface is reflective, then the specular color map is also used as the reflect 
color.

Left: Specular Color Map, Right: Reflective

Transparent Color 

A transparent color map can be used to vary the transparent color of a surface. 

Translucent Color 

A translucency color map can be used to vary the translucent color of a surface.
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Displacement 

Perhaps one of the most powerful new features, displacement maps the 
displacement procedure and creates additional geometry in the scene at render 
time. This means that this new geometry will be added to the calculation of light, 
materials and visibility. Displacing geometry in a scene can increase the render 
time significantly especially if its in high quantity.

Displacement map on a smooth sphere

Anisotropy

Anisotropy (An-iso-tropy) is the effect obtained when a material property is 
dependent on the direction of incoming light, for example, as with highlights that 
are distorted or accentuated on surfaces with very fine grooves or scratches.

Normal Maps

A normal map allows the surface normal of a polygon to be completely defined by 
an image. Similar to bump mapping, a normal map perturbs the surface normal. 
Normal maps replace the surface normal at every point on the surface. This 
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allows lower polygon models to be used but to keep the detail of the surface 
normals as if a more complex model is used. 

Using Maps

The tools for setting up these maps are all found in the Material Editor with 
Settings > Advanced Mode.

Displacement

Both bump maps and displacement maps add realistic 3D effects to materials 
without the need to create the geometry. For example, a bump map included in 
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the material definition of a brick wall will produce realistic brickwork in the 
rendered image without you having to model the bricks and mortar. 

The Material Editor now has bump and displacement map settings and map 
values split up. This is to allow greater flexibility to allow both to be combined. 
Typically displacement maps would be used for more coarse surface 
perturbations and edges and bump maps for finer surface perturbations when 
edges are not visible.

Displacement Maps are images usually TIF or JPG.

Because displacement maps require extra memory and processing time, care 
should be taken with using them. Try to follow the rules below.

Rules for Displacement Mapping

• Use Displacement Maps only when needed.
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• If a Bump or Pattern map give you the same result, then there is no need for a 
Displacement Map. Remember, normal Pattern and Bump maps are material 
properties, whereas a Displacement Map actually is new additional geometry.

• Apply displacement maps on visible items only. If the beautiful wool rug you 
are using in the interior shot is being displaced, but only a small strip of it is 
visible, then slice the rug and only apply the displacement to that small strip. 
Luxology rendering will have to calculate the displacement off screen if there 
are any refractive or reflective materials that may catch the displacement. If 
there are not any refractive or reflective surfaces, Luxology does not have to 
calculate the off screen displacement.

• Adjust the displacement settings in the Render settings properties tab to suit 
the need of the rendered shot. The default Displacement Rate of 1.0 may be 
more than what is needed for the render. Try increasing this setting to 1.5 or 2 
and do a preview or region test render. 

• Slice up displaced geometry to smaller physical segments. This helps Luxology 
in utilizing memory management at render time and will decrease render 
times. There is no need to over do it as you will increase your render times if 
the polygon count goes too high. A little hit and miss experimentation in the 
scene will help you in the long run.

 Exercise: Using Displacement Maps

1 Open the file 04_Advanced Materials.dgn and work in the 
01_Displacement model.

2 From the Visualization task select Apply Materials (A + 2).

3 Assign wood45 to the brown slab.

4 From the Visualization task select Define Materials (A + 1).

5 Open or expand the palette, landscape.pal [Bentley_Materials.dgnlib] and 
select the material: grass field displaced.
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6 Click on the icon for Displacement Maps.
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7 In the Displacement for Grass lawn displaced dialog, click on the Open 
Image File icon.

The Displacement Map is a JPG file. Take note of other settings especially 
Units.
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8 Note the grass_displacements.jpg for the displacement map.

9 Click on Cancel.

10 Close the Displacement for Multiple Materialsgrass field dialog.

11 Select Render (Q + 1).

12 In the Luxology dialog use:

Setup: Draft

Lights: Untitled

Environment: Default
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13 Render View 2.

14 Notice how the smooth edges of the sphere are replaced by the 
displacement map.

15 In the Material Editor change the Displacement (mm) from 150 to 750 and 
re-render.

So the important variable is the image used for the Displacement Map. Several 
are shipped for you and you can download more or create your own.
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Displacement Maps and Memory

Displacement Map can generate a “Luxology Rendering Engine Failed” message. 
After testing and looking at test cases submitted, we believe that 90% of these 
failures are directly related to MEMORY. In some cases this can cause an 
application failure crash. 

There are many factors that can cause excess memory usage. Let us examine the 
most common reported failures. MicroStation uses Modo's defaults for all its 
Luxology rendering setups. These default values work well for small designs or 
test cases. However, Bentley is now finding that in real world MicroStation designs 
these default values can cause excessive memory consumption, leaving us with 
that puzzling message “Luxology Render Engine Failed”.

Displacement Rate

The following settings are found on the Advanced tab of Render Settings dialog.

The Displacement Rate value drives the number of polygons created during Micro 
polygon Displacement rendering. 
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Increasing this number will decrease the number of polygons, an inverse 
relationship. 

Even a small change in the displacement rate will have a huge impact on the 
overall polygon count. The default value of 1.0 basically means that any micro-
polygon that has an edge longer than 1 pixel will be further tessellated (broken up 
into smaller polygons). 

You can think of it as one polygon per pixel. Polygons edges will get smaller until 
the edges get down to the single pixel range or they hit the Minimum Edge Length 
value. This description is not totally precise but it gives you a good working idea. 

Displacement Rate and Minimum Edge Length are basically the same thing. They 
tell the Luxology render engine how small an edge needs to be. The Displacement 
Rate defines the edge in pixel space and the Minimum Edge Length is a geometric 
measurement. So, when Luxology evaluates an edge against the two criteria, it is 
looking at the physical length of the edge to compare for Minimum Edge Length 
and the “visual” length from the cameras perspective when evaluating 
Displacement Rate. 

The Displacement Rate specifies the distance between displacement evaluations 
(basically the desired length of micropolygon edges). The Luxology default is set to 
one pixel which is usually just right, at least in a perfect world, where you have a 
lot of memory. As you can imagine having the length of any edge being 
approximately 1 pixel means that you will never see a faceted curve from too few 
polygons. The problem with the 1 pixel method, is that for large MicroStation 
models and complex scenes it would be much better to have something a little 
less than perfect and know that you can actually render your scene, than having 
to see “Luxology Rendering Engine Failed” message. 

Displacement is adaptive at the micropolygon level. Every polygon edge is 
considered separately. The distance from the camera to the center of the edge, 
the focal length, and the resolution are used to convert the Displacement Rate (in 
pixels) into a distance in world space. If the edge is longer than this and also 
longer than the Minimum Edge Length, it is split in half. This process continues 
recursively until all edges satisfy those requirements.

Since the displacement rate is approximately the edge length of the 
micropolygons, the polygon count will vary with the square of the rate. Even a 
small change like going from 1.0 to 1.4 should cut the number of micropolygons 
by about a factor of two. 
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Finally, the fact that we discuss the edge length in terms of pixels might be slightly 
misleading since these polygons can be oriented in such a way as to not be 
completely perpendicular to the camera's view. Since the edge length calculation 
occurs in world space and not screen space there can, in fact, be many more 
polygons in the image than there are pixels. 

Displacement Ratio

The Displacement Ratio setting allows you to control the amount of sub-division 
in areas of the scene that are not visible to the camera. 

Low values will create more polygons and high values less. 

Displacement Ratio works in tandem with the Displacement Rate setting allowing 
you to balance the amount of micropolygon displacement in a scene, so memory 
usage can be kept to a minimum. You can set this to a fairly high value in most 
cases to improve rendering performance and conserve memory. The Luxology 
default displacement ration is 4.0. Bentley recommends that you use 10.0 as a 
starting point and if you are unhappy with the result you can always make this a 
smaller value. 

What you should do

A Displacement Rate of 2.5 and a Displacement Ratio of 10.0 seems to work much 
better for the typically MicroStation design than the previous defaults of 1.0 and 
4.0 respectively. These defaults use less aggressive, memory friendly values in the 
MicroStation implementation of the Luxology Render Engine. If you are working 
with small designs or test cases you can easily create or modify a setup and use 
the Luxology defaults. 

Clear Coat

The clear coat map changes the perceived thickness of the clear coat lacquer 
effect. Being a value map, black pixels in the map apply a 0% clear coat, and white 
pixels apply the clear coat value defined in the material. The clear coat is reduced 
where the areas of the map are dark.

There are several ways to use Clear Coat maps.

1 Have a Clear Coat material that uses Element Color when Rendering.

2 Increase Clear Coat for a new or existing material.

3 Use Clear Coat with a Multi-Layer material.
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In the following exercise, no materials have been applied, except to the base 
which is Stainless Steel Brushed.

 Exercise: Using Clear Coat Maps

1 Continue in the same file and open the model: 02_Clear Coat.

2 Render View 2 to see initial results.

3 From the Visualization task, select Define Materials (A + 1).

4 Select the Local palette and create a new Material from Materials > New.

5 Name the new material Clear Coat.

6 In the Materials Editor dialog make the Clear Coat value 100.

7 Set the Reflect to 15.
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8 In the Materials Editor, set Color to Element Color.

9 Select Apply Material (A + 2).

10 Use the Local palette.

11 Assign Clear Coat to the first row of solids (sphere, pyramid, elliptical cone 
solid).
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12 Render View 2 with default settings to see results.

13 Open the palette, Clearcoat_Paints.pal [Bentley_Materials.dgnlib].

14 Select the material Dodger Blue and apply to the widget above the sphere.

15 Select the material Silvermine and apply to the chair seat/back.

16 Select the material Clear Coat from the Local palette and apply it to the 
cube in the back.

17 Render View 2 with default settings to the results.

18 Explore the Clear Coat feature with other materials.
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Glow

Glow maps allow an object to give off light, without a light source. Defined in 
lumens per square meter, Glow sets the amount of light that the material appears 
to emit, adding to the overall reflectance of the material. This is independent of 
the amount of incoming light. Useful for creating glowing materials such as Neon 
lights and computer screens. A drop-down menu provides a list of values for 
common items. 

In the following example all illumination has been turned off and a glow value of 1 
is set for the Silvermine material of the chair.

Anisotropy

Rendering with anisotropy gives the effect of the distortion of specular reflections 
or highlights. The Anisotropy value varies from -100% to +100%. This allows 
control over the direction of the scratches on the surface, where -100% 
emphasizes the highlights toward the horizontal direction, and +100% emphasizes 
the highlights toward the vertical direction.

 Exercise: Using Anisotropy

1 Continue in the same file and open the model: 03_Anisotropy.

2 From the Visualization task select Define Materials (A + 1).
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3 Open or expand the palette, Local.pal and create a new material from 
Material > New.

4 Name the new material: perf metal

5 In the Material Editor set the Pattern map to: 
...\Rendering\image\perforated metal-clip.tif

6 In the Pattern for perf metal dialog, set:

Units: Millimeters

Size X: 50

Proportional Lock: Enabled

Transparent Background: Enabled

7 Close the Pattern for perf metal dialog.

8 Set the Bump map to brushed.jpg with the same settings as above.

9 In the Materials Editor set:

Diffuse: 0

Specular: 66

Reflect: 60

Reflection Rays: 512

10 Use Apply Material (A + 2) to apply the material to either surface.
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11 Render (Q +1) the view with default settings.

Fur

When a surface with fur is rendered, the Luxology rendering engine creates 
geometry representing the fur on each surface to which the material is applied. 
This fur geometry uses a geometry cache, the size of which is controlled in the 
Luxology Render Preferences dialog.
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To set the Fur settings on a material select the Fur tab on the top of the material 
editor. Then select the check box for fur. 

The amount of memory used for fur creation is based on the number of fur 
strands which is defined by the fur spacing and length, the size of the elements 
the fur is placed upon and the number of segments each piece of fur contains. It is 
possible that fur creation can exceed the geometry cache size. If this is the case 
the fur spacing should be increased and the number of segments should be 
decreased. This will help reduce the geometry cache size. If it is still not possible 
to render the scene due to the area of fur coverage being large then a different 
technique should be used.

Fur

The toggle button enables Fur for the material such that any element which uses 
the material in the design file will now be covered with fur as specified in the 
dialog.
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Length

Length is a master unit value which is the length of each individual fur strand. This 
value can be randomly modified by settings described further on in this section. 

 Exercise: Setup a Fur Material

1 Continue in 04_Advanced Materials.dgn and open the model 04_Fur.

Materials for the wall and the text have been applied for you and the text 
is 50 mm (2 inches) tall.

2 From the Visualization task, select Define Materials (A + 1).

3 Select the Landscape palette and select the material Grass Lawn.

4 Right click on the material and select Copy.

5 Select the Local Palette, right click and select Paste.

6 Select the image: grass06.jpg
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7 Select the material Grass Lawn in the local palette, right click and rename 
it to Grass Fur.

Note: Note: This is a great way to create materials. Just copy from the 
delivered MicroStation palettes to a local palette and rename. You can 
then tweak the settings to your liking without changing the original 
material. 

8 In the Materials Editor dialog select the Fur tab and use the following 
settings:

MicroStation is saving these changes as you go.

9 Select Render (Q + 1).

10 Render using:

Setup: Draft

Lights: Untitled

Environment: Default

Spacing

This is a master unit value is the spacing between individual strands of fur. Again 
this value can be randomly modified by settings described later on. In the 
previous image the spacing is 5mm and in the next exercise you will change the 
Spacing 15mm and the fur effect is much thinner.
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 Exercise: Change Fur Spacing

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and change:

Spacing: 0.015m

3 Select Render (Q +1).

4 Render using the previous settings.

Offset

Offset is the distance that the fur is offset on the surface it is created from. In the 
previous exercises the offset was 0mm so the fur is on the surface and in the 
exercise below the offset will be 100mm.

 Exercise: Using Fur Offset

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and change:

Spacing: 0.005m

3 In the Materials Editor dialog select Fur and change:

Offset: 0.1m

4 Select Render (Q +1).
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5 Render using the previous settings.

Width

The width at the root of each fur strand is a percentage of the spacing between 
individual strands. In the previous exercises the width is 10% and the spacing is 
5mm making the width 0.5mm. In the exercise below the width is 50% making the 
width of the strand 2.5mm

 Exercise: Using Fur Width

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and set:

Offset: 0.00m

3 In the Materials Editor dialog select Fur and set

Width: 50%

4 Select Render (Q +1).
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5 Render using the previous settings.

Taper

The taper value allows the width of the fur strand to be reduced over its length. A 
taper of 0% means the width of the root and tip of each fur strand is the same. A 
taper of 50% reduces the width by 50% at the tip of the strand. 100% means the 
tip comes to a point.

 Exercise: Using Taper

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and set

Taper: 50%

3 Select Render (Q +1).
Aug-12 227 Advanced Materials
Copyright © 2012 Bentley Systems, Incorporated



Using Maps
4 Render using the previous settings.

Type

There are 2 types of geometry which can be created for individual fur strands. 
These are strips which is the type that all the above images have been using and 
cylinders where each fur strand is a cylinder. Note using cylinders for fur requires 
more memory for the geometry cache and also takes longer to render individual 
images.

Strip Rotation

This value will randomly rotate individual fur strands at their root. A value of 
100% will give a random rotation of up to 180 degrees. In the previous exercises 
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the strip rotation is 0 and all the random jitter variables are set to 0. In the image 
below the strip rotation is set to 50%, with other settings reset to default.

Segments

This is the maximum number of sections which make up a fur strand. A strand 
which has more bend will require more segments in order to display smoother 
curvature. More segments requires more memory.

Adaptive Sampling

Adaptive Sampling is important to turn on.

Enabling this toggle will decrease the density of the fur as it recedes away from 
the camera, reducing the overall memory requirement for the fur geometry. This 
setting is used in conjunction with the Fur Rate setting below. The amount of fur is 
reduced the further away from the camera it is.

Fur Rate

Fur Rate specifies a threshold that Adaptive Sampling uses to reduce the number 
of fur strands. This is calculated as an average distance in pixels between 2 fibers. 
This setting is best used when there are large numbers of fur strands which 
recede into the distance, for example, grassy fields. Larger values for fur rate 
increases the amount of reduction of fur density with distance from the camera. 
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Clumps

This is the effect of small groups of fur strands gathering together in small groups. 
Higher values of this setting will cause a tighter grouping of the strands. The next 
exercise uses a clump value of 10% and then one with a value of 60%.

 Exercise: Using Clumping

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and set

Length: 0.05

Spacing: 0.005

Offset: 0

Width: 10

Taper: 100

Clumps: 50

Clump Range: 0.1

3 Select Render (Q +1).

4 Render using the previous settings.
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Clump Range

This distance sets the average area of fur strands which will gather together and is 
based on the Clump percentage. The larger the number the farther apart the 
clumps will be.

Clump Range set to 0.25

Growth

This value will increase the randomness of the growth of the fur strand along its 
length. The previous exercises have had no growth jitter.

 Exercise: Using Growth Jitter

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and change:

Clumps: 0
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3 In the Materials Editor dialog select Fur and change

Growth Jitter: 50%

4 Select Render (Q +1).

5 Render using the previous settings.

Position Jitter

This value will increase the randomness of the position of the fur strands. This 
only has an effect when the fur spacing is large.
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Direction

This value will randomize the angle of rotation for the root of the fur strand. This 
is similar to strip rotation; however this value will also randomize the fur strands 
bend direction. 

With 0 Direction Jitter

Size

Size will randomize the overall scale of each fur strand. This change is most 
noticeable around the edge of the fur.

Flex

Flex causes individual fur strands to bend. A value of 0 will produce straight fur 
strands and a value of 100% will cause the fur strand to bend 180 degrees. 

Root Bend

When Root Bend value is 0% the direction of the fur strand is based on the 
smoothed polygon normal at the base of the fur strand. As the value is increased 
to 100% the fur strands lay over towards the surface in the direction of the fur 
growth. 
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Map Options

Some settings can be set by an image instead of a hard coded value as you have 
been doing. To set the image use the Map icon. 

Fur Length Map

Fur Length Map can be used to determine the height of the fur across a surface. 
The height of the fur is based upon the intensity of the pixel in the image. Where 
a white pixel will produce full height fur strands a black pixel will produce 0 height 
fur strands. 

This is an excellent way of showing an underlying pattern with fur.

 Exercise: Using Fur Length Map

1 Continue in the same file and model.

2 In the Materials Editor dialog select Fur and select the Fur Length Map 
icon.

3 Select the image: ...\System\materials\bumps\DepthExample.png with 
the following settings:

Units: Meters

Size X: 0.5
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Size Y: 0.5

4 Select Render (Q +1).

5 Render using the previous settings.

Fur Spacing Map

This map controls the fur density across a surface. The darker the pixel in the 
image the less dense the fur will be in this area. 

Fur Clumping Map

This map controls the clumping of the fur across a surface. Used in combination 
with the fur clumping value, the intensity of the pixel in the map scales the fur 
clumping value. Such that a black pixel will result in no clumping and a white pixel 
will result in using the clumping value set in the dialog.

Fur Flex Map

This map controls the amount of fur flex across a surface. Again the intensity of 
the pixels in the map combine with the flex amount set in the dialog to control the 
fur flex across the surface
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Using RPC Cells

MicroStation supports ArchVision Rich Photorealistic Content (RPC) 3D textures, 
such as realPeople, realTrees, and RPC 3.0 content such as RPC Automobiles and 
Objects. RPCs are replaced dynamically, at render time, with images from the RPC 
files that are appropriate for the current viewing direction. That is, during 
rendering, the RPC are replaced by geometry and texture maps extracted from 
the RPC files. The maps selected are determined by the orientation of the camera 
with respect to the RPC.

ArchVision Content Manager

For newer RPC content, ArchVision Content Manager is required, along with an 
ArchVision licence. From MicroStation, you can access the ArchVision Content 
Manager via the Configure Content button in the RPC Thumbnail Browser. Refer 
to ArchVision (www.archvision.com) for information on RPC and their licensing.

Where required, MicroStation's thumbnail browser may be disabled via a 
configuration variable. To disable the RPC thumbnail browser, set the 
configuration variable MS_DISABLE_RPCBROWSER to value of 1. To re-enable the 
browser, set the configuration variable to 0 (zero), or leave blank.

The RPC Task

Tools for placing and editing RPCs are located in the RPC tools tool box, which is 
opened by selecting Tools > Visualization > RPC Tools.
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You use the Place RPC tool to place RPC in a model. Settings for this tool let you 
select, via combo boxes, a Directory, Category, and Name, for the RPC. Additional 
controls let you browse for a directory, refresh the combo boxes, or view the RPC 
content via a thumbnail browser.

If it is the first time placing an RPC, you will automatically be presented with the 
file browser to locate the folder where the RPC files are stored.

Other tool settings let you Set the Height, Scale, and Size Variation for the RPC. A 
Random rotation setting lets you place RPCs with random rotation, without 
having to define the target direction for the RPC.

When you first use this tool, all the directories in the search path will be scanned 
for RPC files.

The search path is the list of directories defined by the environment variables 
MS_PATTERN, MS_BUMP, MS_IMAGE, and MS_DEF. Any time the contents of a 
directory is changed, it will be re-scanned. If for any reason the combo boxes do 
not accurately list the RPC files present, you can click the Refresh button 
(immediately to the right of the Browse button. A Reset will abort the scanning for 
RPC files.

You use the Edit RPC tool to edit the settings for an existing RPC in a model. This 
includes the option to change the RPC as well as to modify its various settings.

 Exercise: Using a RPC file

1 Continue in 04_Advanced Materials.dgn and open the model: 05_RPC.

2 Select the Place RPC Cell tool (D + 1).

3 Set Directory to: ...\Workspace\Projects\Rendering\RPC, if not already set.
Aug-12 237 Advanced Materials
Copyright © 2012 Bentley Systems, Incorporated



Using RPC Cells
Category: Demo

Name: Oak (HiRes)

Scale: 100%

The RPC is being placed from its base.

4 Place the RPC behind and to the right of the bench, by snapping to the 
terrain surface and the enter a data point to accept the snap location.

5 Read the prompt.

6 Rotate the RPC so that it is facing the bench. Enter a data point to accept 
rotation.

7 Select Render (Q + 1).
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8 Render View 2 with default settings.

You can purchase RPC’s from http://www.archvision.com
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Populate Content

The Populate Content tool allows the placement of cells or RPC on any surface in a 
design file. The tool will automatically calculate the top most surface in the Z 
direction and place the items at the correct height. This tool provides the ability 
for randomly selecting items from a library of defined cells, models or RPC with 
random spacing and placement characteristics, making this tool ideally suited for 
rapidly placing trees and foliage into your 3D scene.

There are three modes of operation in the Populate Content functionality, 
depending on if you want to place a single item on a surface or a set of items 
along a path or fill an area with items:

• Populate Single

• Populate Along Path

• Populate in Area

At each data point an item will be placed on the surface below it in the view 
selected.

Populate Single 

Content 

This option button is populated with a list of the sets of items to place when using 
the tool. The magnifying glass next to it opens a dialog which allows the creation 
and maintenance of sets of items for use by the tool. This dialog is described later 
in this document 
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Item 

This item lists all the entries in the chosen content set to place. Here an individual 
item can be selected or by selecting the Random option an item will be randomly 
picked from the set every time an item is required for placement.

Paint Surface 

When this check box is selected the tool will enable the user to paint the surface 
with items. The operation of this is similar to the stream curve tool where a series 
of items will be placed at the cursor location as it moves across the view. The 
spacing of the items is dependent on the “Item Spacing” settings below the tool 
mode icons. 

Mode Icons 

These icons switch the operation of the tool between Populate Single, Populate 
along Path, and Populate in Area.

Item Spacing 

This item is only available when using the Paint Surface mode of the tool. It 
determines the spacing between successive items placed. So if it is set to 15 and 
the units in the extended tool settings are set to meters then when the cursor 
moves 15 meters from the last item placement point then another item will be 
placed. The option button to the right of this item allows the spacing between 
these items to be varied based on a percentage of the distance used.

Units 

When using the item spacing with the Paint Surface mode this item specifies the 
units of the distance to be used. It is defaulted to the same units as the design file.
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Populate Along Path

This mode of the tool will place items at specified points along a path. Once the 
path has been selected prompts to select the start and end points of placement 
will be displayed followed by a data point to accept the placement.

Content 

This option button is populated with a list of the sets of items to place when using 
the tool. The magnifying glass next to it opens a dialog which allows the creation 
and maintenance of sets of items for use by the tool. This dialog is described later 
in this document. 

Item 

This field lists all the entries in the chosen content set to place. Here an individual 
item can be selected or by selecting the Random option an item will be randomly 
picked from the set every time an item is required for placement.

Item Spacing 

This field determines the spacing between successive items placed. So if it is set to 
10 and the units in the extended tool settings are set to meters then at 10 meter 
intervals along the path another item will be placed. The option button to the 
right of this item allows the spacing between these items to be varied randomly 
based on a percentage of the distance used.

Path Offset 

This field enables the items to be placed offset from the path by the distance 
specified in the text item, again the units are as determined by the units value in 
Advanced Materials 242 Aug-12
Copyright © 2012 Bentley Systems, Incorporated



Populate Content
the extended section of the tool settings. The option button to the right allows 
this value to be randomly varied by the percentage specified. 

Units 

When using the field Spacing of Path Offset, the Unit field specifies the units of 
the distance to be used. It is defaulted to the same units as the design file.

Random Seed 

This value will regenerate the items displayed and selected based on a different 
random number base. This will provide a different variation of items selected and 
distances used.

Populate in Area

This mode of the tool will fill a shape with items based on the criteria specified in 
the tool. Simply identify the shape to be populated (or if populating a fence is 
required then check the Use Fence option). Then items will be placed on the 
surface within the area. 

Content 

This option button is populated with a list of the sets of items to place when using 
the tool. The magnifying glass next to it opens a dialog which allows the creation 
and maintenance of sets of items for use by the tool. This dialog is described later 
in this document. 
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Item 

This field lists all the entries in the chosen content set to place. Here an individual 
item can be selected or by selecting the Random option an item will be randomly 
picked from the set every time an item is required for placement. 

Item Spacing 

This field determines the spacing between successive items placed. So if it is set to 
10 and the units in the extended tool settings are set to meters then at no item 
will be placed within a 10 meter radius of the current item. The option button to 
the right of this item allows the spacing between these items to be varied 
randomly based on a percentage of the distance used.

Units 

When using the field Spacing of Path Offset, the Unit field specifies the units of 
the distance to be used. It defaults to the same units as the design file.

Random Seed 

This value will regenerate the items displayed and selected based on a different 
random number base. This will provide a different variation of items selected and 
distances used.

 Exercise: Populate Area

1 Load the drawing in 05_Populate.dgn and open the model: 01_Populate.

2 Select the Populate tool (D + 3). 

The Populate in Area dialog appears.
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3 Set the following:

• Content: RPC trees

• Item: Random

• Alignment: Vertical

If you click on the magnifying glass you can see and configure the RPC 
trees that you will place with this command.

You might recognize the model from the last exercise where we placed a 
single RPC cell and had to manipulate the tree so it was in the correct 
elevation and hit the DTM so it looked appropriate. The Populate 
command takes care of all of that. 

4 Set your active level to Trees.

5 Select the Place Block command (F+1).
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6 Draw a Block over the DTM as shown in the figure below:

7 Select the Populate tool (D + 3).

8 Select Populate in Area.

9 It prompts you to select the shape. Select the Block that you just drew.

You will see the Trees populate the area. Select the saved view bench and 
look at your populate command.
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Content Library 

The content library provides the facility to create and maintain a set of differing 
types of content to be used by the tool. These content items can either be cells, 
models or RPC.

New 

This icon will create a new entry in the contents set list column allowing the user 
to set the name of the entry. A series of cells, rpc's etc can be added to this set.

Save 

When the contents of a contents set have been changed the changes are saved to 
file when this icon is used. 

Copy 

This icon will copy the currently selected list of contents to a new list with a 
different name 

Delete 

This icon will delete the currently selected contents set item.

Reset 

This icon will reset the currently unsaved changes to the list 
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Update From Library 

If the origin of this list of contents is from another file such as a dgnlib and it is 
different in the active file from the originating file this icon will reset the list to the 
state that the list is in the library.

Add Item 

This icon will open the Add Files dialog.

This dialog allows the user to open a .dgn,.cel,.dgnlib etc. file and select a series of 
models within that file for use as items to place. The user has the option of 
selecting one or more of the entries in the list and these will then be added with 
the associated options into the item list of the main contents library dialog. 

Scale 

This is a scale factor to apply to the item when placed. 

Scale Variation 

This value is a percentage which will be used in conjunction with the scale value 
to enable a random variation in height to be setup.

Placement Type 

This option button provides the ability to select how the items are placed next to 
each other. They can either be placed Center To Center, which means that the item 
spacing will be the distance of the center of one item to the center of the next 
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item. Another option is Edge To Edge, which means that the spacing is from the 
edge of the range of one item to the edge of the range to the next item.

Placement Origin 

The point of the item which is placed on the surface is specified with this option 
button. It can either be Cell Origin, where the origin of the cell is the point that 
the item is located on the surface, or it can be Range Bottom Center where the 
lowest point in the Z range of the item is used in conjunction with the center in x 
and y as the placement point. 

Rotation

This is the angle at which the contents of the model should be rotated when the 
item is placed so that it is facing a specific direction. If there is not an entry in the 
field, the rotation will be in a random direction.

Cell Contains Lights 

If the cell being placed contains lights, then this item must be checked so the 
lights can be processed correctly. 

Add RPC 

This field activates the Add RPC Files dialog, which allows the addition of RPC into 
the system.

This dialog allows the user to select a series of RPC for use as items to place. The 
user has the option of selecting one or more of the entries in the list and these 
will then be added with the associated options into the item list of the main 
contents library dialog.
Aug-12 249 Advanced Materials
Copyright © 2012 Bentley Systems, Incorporated



Populate Content
Scale 

This is a scale factor to apply to the item when placed.

Scale Variation 

This value is a percentage which will be used in conjunction with the scale value 
to enable a random variation in height to be setup.

Placement Type 

This option button provides the ability to select how the items are placed next to 
each other. They can either be placed Center To Center, which means that the item 
spacing will be the distance of the center of one item to the center of the next 
item. Another option is Edge To Edge, which means that the spacing is from the 
edge of the range of one item to the edge of the range to the next item. 

Placement Origin 

The point of the item which is placed on the surface is specified with this option 
button. It can either be Cell Origin, where the origin of the cell is the point that 
the item is located on the surface, or Range Bottom Center where the lowest 
point in the Z range of the item is used in conjunction with the center in x and y as 
the placement point.

Rotation 

This is the angle at which the RPC should be rotated when it is placed so that it is 
facing a specific direction. If there is not an entry in the field, the rotation will be 
in a random direction.
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Stencil

The stencil tools are effective tools, but they will probably be use more for 
animation than Rendering. This functionality allows you to stencil, or what is 
better known as drape, 2D elements on to 3D geometry. For rendering it will be 
helpful for tasks such as putting striping on the surface of a road or a parking lot.

Stencil 2D reference Elements on 3D Geometry

The first icon allows you to stencil or drape elements from a reference file on to 
your 3D geometry. The elements have to be 2D elements.

Stencil Selected Elements

The second icon allows you to drape 2D elements in the active file on to 3D 
geometry. 

Remove original elements

Turn on this check box to delete the original element when draped. Otherwise the 
original line stays intact.

Surface Offset

Offsets the draped element above the 3D geometry in accordance with the 
tolerance listed in the Tolerance field.

Direction

Set to either View or Z. Drapes in the direction that you have selected.
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 Exercise: Stencil Element

1 Continue in the drawing in 05_Populate.dgn and the model: 01_Populate.

2 Set the active level to Path.

3 Select the Place Block tool (F + 1).

4 Place a Block 4' wide behind the Bench as shown in the figure below. This 
will be our walking path.

5 Turn off the level Trees.

6 Select the Stencil Tool (D + 4).

7 In the Stencil Selected Elements dialog, set the Offset to .3ft. This will 
offset the path 4 inches above the DTM.

8 Select block that you placed for the path. 
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9 Notice how the path is draped on the DTM. Select the saved View Bench.
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Module Overview

Output of data can come in the form of images and 3D PDF. You can produce your 
own output locally or use a distributed rendering farm.

Module Prerequisites
• Basic knowledge of MicroStation printing

• Knowledge of View Controls

• Basic knowledge of Image formats like JPG, TIF, etc.

Module Objectives

After completing this module, you will be able to:

• Save Image

• Save Panorama

• Distributed Rendering

• 3D PDF

• Export to Luxology, SketchUp

Image Output 

There are many ways to share your computer graphics imagery (CGI). One way is 
to create a 3D PDF of your rendered model; another is to Save an image to disk.
Aug-12 255 Creating Ouput

Copyright © 2012 Bentley Systems, Incorporated



Image Output
Save MicroStation Image

Now that you can set up and create rendered images of your models, you might 
want to save one or more of them and impress your friends and clients by sending 
them a file containing the image. You can quickly save MicroStation images using 
the Save option in the Utilities > Image menu.

You have many choices when saving your images, such as file format, resolution 
and type of shading. As well as being able to save your images, MicroStation 
provides a viewing facility and a way to perform limited modifications.

There are many variables that you can adjust when saving images, however, you 
will find that most remain consistent once you begin to integrate images into your 
workflow. 

These tools are found on the Utilities > Image menu. In addition to these basics 
you can also convert images, capture the screen as an image and save an image 
using multiple computers to speed up the processing time.

To save an image to disk you can use the Render Image to File tool located in the 
visualization task, or Tools>Visualization>Render or access the dialog by going to 
Utilities > Image > Save.
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Here you can choose several things, including: Format, DPI and Render Mode. For 
a quick test choose Luxology from Render Mode.

Saving a MicroStation rendered image

To save an image, select Utilities > Image > Save, which opens the Save Image 
dialog.

• View controls which view will be rendered.

• Format controls the type of file format in which the image file will be saved. 
MicroStation supports a wide variety of file formats including JPG, TIF, TGA, 
Postscript, PCX and others.

• Compression selects the type of file compression for those formats that allow 
it. For example, if you select JPEG then you have the option of choosing High 
Loss (high compression) through to Minimum Loss (high quality).

• Mode lets you select the bit depth of the image or grey scale.

• Shading lets you select which type of shading to use. For high quality images 
that cast shadows, select RayTrace shading mode.

• Shading Types lets you select between Normal, Antialias and Stereo.

• Action is set to Ray Trace, Radiosity, or Particle Trace only. Sets the rendering 
action to be performed.

• Resolution controls how large an image you produce, in terms of pixels. 
Thought should be given to displaying the saved image. In order to display the 
saved image, you must have enough RAM on your video card to hold the 
image. This depends also on what bit depth (24 bit or 8 bit) you select in 
Mode.

When one of the Resolution values (X or Y) is adjusted the other updates to 
maintain the view aspect ratio. Using higher resolution allows you to have 
more pixels to work with, hence a finer quality image.

• Gamma Correction controls the white content of an image. The values range 
from 0.10 to 3.00. A value of 0.10 is very dark while 3.00 is very bright.

Image Size lets you control the output size of the image in pixels, or unit as well as 
how many dots per inch are recorded.

Banded Rendering allows for an image to be broken up into strips or bands for 
network rendering.
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Distributed Rendering lets you process an image using 2 or more PCs networked 
together.

After specifying the settings for your image, you can save the image with a unique 
file name and place it on your hard drive. The default location in which 
MicroStation stores image files is the out directory, such as 
…\Workspace\projects\examples\General\out.

Viewing a saved image

MicroStation has a viewing utility that lets you view your saved rendered images 
and perform a number of editing and manipulation operations.

To view a rendered image, from within MicroStation, select Utilities > Image > 
Display.

Save Multiple Images

In addition to saving single image files you can set up your system to save a series 
of images. This is especially useful for automatically creating and saving rendered 
images and panoramas during the hours when your system normally is not in use. 
To do this, you first create a script that contains the names of the files and models 
to be rendered, along with the view number or the saved view to be used. A Save 
Multiple Image script can even recall a rendering setup that could change the 
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time of day, background, or any other rendering setting, saved in the rendering 
setup file.

Once this script is written and executed, MicroStation will open the model in the 
design file, load the appropriate rendering set ups or saved views, then render the 
desired images to any of the supported raster formats. In addition you can set the 
resolution and choose from any of the rendering or hidden line options.

Note: When rendering multiple images from several different models or design files 
you should set up saved views in each model or design file. You can also use 
rendering setup files to change a variety of rendering settings, such as global 
lighting settings, general settings for fog, or even to turn the background image 
on or off in the target view. In the following exercise, you will use the Save 
Multiple Images dialog box to create a script file containing a list of rendering 
commands to create images or panoramas to disk.

 Exercise: Save multiple images

1 From File Open select:

User: examples

Project: General

2 Open PhotoRealistic Rendering.dgn and open the model Cool Home 

3 Open Utilities > Image > Save Multiple.

The Save Multiple Images dialog box opens.

4 In the Save Multiple Images dialog, click the New Entry icon.

A new entry, which is highlighted, is added to the Save Multiple Images 
dialog box and the Edit Script Entry dialog box opens. This dialog box lets 
you adjust the settings for the highlighted script entry as follows:

View Number: 1

Render Setup: Untitled
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Render Mode: Luxology

Light Setup: From View

Environment Setup: Untitled

Gamma Correction: 1.7

Image Size X: 640

Aspect: Enabled

5 Open the Model: Cool Home furniture.

6 Click the New Entry icon again and enter the following script entry data:

View Number: 2

Render Setup: Untitled

Render Mode: Luxology

Light Setup: From View

Environment Setup: Untitled

Gamma Correction: 1.7

Image Size X: 640

Aspect: Enabled

7 Select File > Execute and save the script file.

The images will be created in ...\Examples\General\out\ folder.

8 Go to Utilities > Image > Display to view the created images.
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Note: From the Edit Script Entry dialog box you can choose the design file you wish to 
render. By default when you first create a new entry it will assume the current 
model in the current file. The output file name uses a default macro that 
defines the design file name and a number that is automatically increment to 
prevent accidently over writing an existing image file from the same model/
DGN file.
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Save Luxology Rendered Image

The Save Luxology Render tool is located in the Luxology Render dialog.

Saving a Luxology rendered image is identical to the Save As dialog. All standard 
formats are available as well as “Radiance High Dynamic Range” (HDR) format.

Copy Luxology Rendering to Clipboard is a convenient tool for copying an image 
into a document.
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Save Panorama Image

Imagine being able to look at your rendered model in real time and dynamically 
pan around it with anti-aliased Ray Traced or Particle Traced results. You can do 
this by saving images as a Panorama.

MicroStation provides the ability to create panorama files that can be viewed 
using third party applications, such as Apple Computer’s QuickTime player. Such 
players let you interactively view the panorama image by changing the initial view 
point from which the image is viewed. Additionally, when a complete QuickTime 
application installation is detected, further options are available during the 
panorama creation process. These include:

• Saving panorama output to a QuickTime VR file (.MOV extension).

• Additional panorama types for creating Image Object panoramas.

To start the panorama image creation process, you select Utilities > Image > Save 
Panorama, which opens the Save Panorama dialog box. You will first get an 
Information window describing the need for installation of QuickTime Player.

This dialog box provides options for generating standard panoramas:

• Cube — creates images that let you view forward, backward, left, right, up, 
and down.

• Cylinder — creates images that you view in the horizontal direction only.

When the full version of QuickTime is installed, additional options are made 
available in the Save Panorama dialog box:
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• Object - Sphere — creates images that let you view the target object from any 
direction. 

• Object - Top Hemisphere — creates images that let you view the target object 
from any position from horizontal to directly above.

• Object - Circle — creates images that let you view the target object from a fixed 
altitude.

• Object - Custom — lets you specify the minimum and maximum altitudes for 
viewing the target object.

In each of the QuickTime panorama types, the camera will revolve 360° around 
the target object. The number of frames created at each altitude is set by the 
Frames field in the Save Panorama dialog box.

QuickTime requirements

In order to use the advanced QuickTime VR functionality, a complete QuickTime 
installation must be loaded. To ensure this, during the installation of QuickTime, 
make sure you select Custom installation and install ALL of the components listed. 
A no-cost version of QuickTime can be obtained from the Apple Computer web 
site located at:

http://www.apple.com/quicktime/download/standalone

Select Operating System Windows XP or Vista

When installing QuickTime choose Custom Installation as shown in the following 
image.

QuickTime Installer Choose Installation Type
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After choosing Custom click Next to go on to next dialog box.

QuickTime Select Components

Click Select All then Next to continue with installation.

In order for Save Panorama to be able to use the QuickTime VR formats, the 
libraries QTJavaNative.dll and QuickTime.qts must be present in the windows 
system32 folder. Both of these critical files are installed as part of the full 
QuickTime application installation process.

Note: If the QuickTime setup program does not let you install QuickTime for Java, it 
may be because the Java 2 Runtime Environment cannot be found on your 
computer. In this situation, you should exit from the QuickTime setup and 
install the Java 2 Runtime

Environment. Java 2 Runtime Environment can be obtained from the Sun 
Microsystems web site location:

http://java.sun.com/j2se/1.3/jre/download-windows.html.

Follow the instructions to download and install the Java 2 Runtime Environment, 
Standard Edition. Once this has been installed, the QuickTime setup program will 
let you install QuickTime for Java.

Using Alternate QuickTime Video Codecs

QuickTime uses a data codec (short for compress-decompress) to compress image 
data written to the QuickTime VR movie files. This codec determines the data 
format used to store each image. The codec that is selected is the one that 
matches the format that you select for the output image. The following output 
formats have a matching codec:
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• JPEG

• TGA

• PNG

• BMP

• TIFF

If you select a file format that is not in this list, the TIFF codec will be used by 
default. You can override the codec selection by setting the configuration variable

MS_QTVR_CODEC_TYPE to jpeg, tga, png, bmp, or tiff. When set, the codec 
defined by this variable is used, regardless of the selected output format. Changes 
that you make to the configuration variable, MS_QTVR_CODEC_TYPE take effect 
immediately. You do not have to restart MicroStation.

In the next exercise you will be setting up a camera vantage point and creating a 
cubic

panorama. With the cube type panorama you can achieve a truly immersive VR 
effect. The cube panorama will be rendered as 6 faces of a box, with the camera 
being inside. The 6 images, or pictures, taken during the process will be shot using 
a camera lens angle of 90 degrees.

 Exercise: Save a panorama image file

1 Open the Loft model in PhotoRealistic Rendering.dgn

2 Open the Utilities > Image > Save Panorama dialog with the following 
settings:

View: 2

Mode: RGB

Render Setup: Draft

Render Mode: Luxology

Light Setup: Afternoon

Environment Setup: Physical Sky

Panorama Type: Cube

Resolution X= 512

Resolution Y= 512

Gamma Correction = 1.7
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3 Save as panoramaexercise.mov to begin panorama saving process.

Note: An continuous image will display as each band is saved in process.

Note: For a panorama to be created, a camera must be enabled in the view 
from which you are creating the panorama. The view you choose, 
therefore, automatically will be converted to a camera view if one does 
not currently exist. To achieve the best results you should set up a 
camera view prior to creating the panorama and place the eye point 
toward the center of the room, rather than in a corner.

Viewing the Panorama File

After the Panorama has be created, the QuickTime panel will open with the 
panoramaexercise.mov file.

Manipulate the image left, right, up and down by selecting one of the arrow keys 
then place the cursor on the image and move in any desired direction.

Zoom in and out by selecting the + or - key.
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Distributed Rendering 

You can use several machines to do one rendering or animation by using 
Distributed Rendering. Distributed Rendering now is included and does not have 
to be downloaded as a separate package. Its basic requirement is that all 
processors taking part in the rendering have access to all the DGN, texture, RPC, 
and raster files to be used in the rendering. It is also necessary that all processors 
taking part in the rendering have access to the output path.

Simplified setup for Distributed Rendering 

Setting up this new version of Distributed Rendering is simple and it does not 
require any external database server as was required previously. To use 
Distributed Rendering, you must first launch the Distributed Processing Controller 
from the MicroStation start menu. 

The first time that you start the controller, you are prompted to define your 
Shared (probably server) Directory. This determines where Distributed Rendering 
stores the information it needs to configure your controller and pass data back 
and forth between multiple machines. All machines that will participate in the 
rendering 
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Distributed Rendering Work Flow Chart

 How to set up Distributed Rendering

1 From the Start menu, select Bentley > MicroStation V8i > Process 
Controller for Distributed Rendering.

The Configuration Settings dialog opens. 

2 To select a Shared directory, click the button to the right of the field.
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3 Select a shared folder and click OK.

4 Click OK.

5 When Distributed Rendering is available, the Bentley Distributed 
Processing Scheduler icon appears in the System tray.

Distributed Rendering Related dialogs 

The Scheduler is accessed by right-clicking the Process Controller tray icon and 
choosing Open Scheduler. The Job Monitor is accessed by right-clicking the 
Process Controller tray icon and choosing Open Job Monitor.

Scheduler 

The Scheduler dialog is used to schedule times that your system is available for 
contributing to processing images. 

Job Monitor 

The Job Monitor dialog displays the progress of your distributed rendering tasks.

Luxology Network Rendering

Selecting the Begin Network Rendering tool in the Luxology Rendering dialog, 
creates a distributed rendering job that renders a new solution of a selected view 
or, if a fence is present in the view, the fence contents.

Note: When using distributed rendering from the Luxology dialog, it is not necessary 
to have design and workspace resources shared on the network. These assets 
are converted to a render-optimized format and copied to the distributed 
rendering shared directory for use by other distributed render machines. The 
machine that submits the job has to complete the preprocessing phase and 
package the design resources by itself. After that, one machine handles the 
illumination computation phase by itself (if Irradiance Caching is turned on in 
the active render setup). Once there is no more illumination to compute, all the 
other machines join in the rendering job. 

After submitting a distributed rendering job from the Luxology dialog, clicking 
Cancel in the Luxology dialog cancels the distributed rendering job for all 
machines. Closing the Luxology dialog while the distributed rendering is active 
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only causes the active session to stop previewing and participating in the 
distributed rendering job. If there are still other machines working on the 
distributed rendering job, the final result is placed in the Network Image History 
folder.

Luxology Network Rendering Options

Clicking the Down arrow next to the Begin Network Rendering tool, will display 
the network rendering options.

Network Image History – Specifies the folder in which the .bimg files created by 
Luxology distributed rendering are placed. 

This is different from the Luxology history folder because that directory may not 
be accessible to other machines that participate in distributed rendering jobs. If 
this directory is not accessible by other machines, Luxology distributed rendering 
jobs may not succeed.

Maximum Tile Size – Specifies the largest size for each distributed rendering tile. 
In general, larger tile sizes offer better performance. Use a smaller tile size only if 
there are many machines participating in the distributed rendering job to ensure 
that each gets its own tile on which to work.

Group – Specifies the distributed rendering that will be allowed to participate in 
this job.

Include Current Session – Specifies whether or not the current session will also 
work on the distributed rendering job. If this option is checked, the current 
session handles the illumination computation phase of the rendering. This is an 
easy way to ensure that the most powerful machine in a distributed rendering 
farm handles this phase, which is important since this is the longest portion of 
rendering an image that cannot be distributed across multiple machines.
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Saving 3D Content in PDF Files

With the release of Adobe® Reader® 9.0, Adobe’s PDF format supports the 
embedding of 3D content within documents. In MicroStation, the creation of PDF 
documents with 3D content is similar to printing a standard 2D document.

Where 3D content is included, it will contain any visualization data and settings 
that already exist within the design file, such as lights, materials, texture maps, 
and animation or camera movement (flythroughs). Additionally, Saved Views are 
included in the 3D content.

Any 3D content within a PDF document is stored in “Universal 3D” (U3D) format. 
This format was introduced by the 3D Industry Forum (http://www.3dif.org/) as a 
means for transferring three dimensional data from CAD systems to mainstream 
applications such as marketing, training, sales, technical support, and customer 
service. MicroStation lets you export geometry directly to U3D, or to seamlessly 
create PDF documents with embedded U3D objects.

Adding 3D content from design models

From a 3D design model, you can add 3D content to a PDF file simply by selecting 
Bentley Driver and enabling the Print to 3D setting in the Print dialog box.

3D Plotting Options

Settings that control the 3D content are found in the 3D Plotting Options dialog 
box (Settings > 3D Plotting, in the Print dialog box). These settings, which are 
saved in the user preference file, are retained between sessions.

Animation in 3D content

Animation scripts created with MicroStation’s Animation Producer (Utilities > 
Render > Animation) can be used to specify geometry or camera motion that can 
be exported to U3D and viewed dynamically within the PDF document. When a 
model is saved to U3D either the default script (a file with same name as design 
file but “.msa”) extension, or the script currently loaded in the animator, is used to 
specify the U3D animation. In Adobe Reader, the animation can be started or 
paused by selecting the 3D object and then selecting the “Start Animation” or 
“Pause Animation” buttons from the tool bar.
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Creating 3D content in PDF

To demonstrate this feature, in the next exercise you will create a PDF file that 
contains 3D content. The data set that you will use also includes an animation 
script for a simple fly around of a building. The animation script is provided for 
you to see this functionality when creating the PDF file. Details on the creation of 
the animation, however, is beyond the scope of this book.

 Exercise: 3D in PDF from a design model

1 Open the model Loft in PhotoRealistic Rendering.dgn.

2 From MicroStation main menu choose File > Print to open the Print dialog 
box.

3 Set the Printer to Bentley Driver, and select pdf.pltcfg as the printer driver.

4 In the Print dialog box, turn on Print To 3D.

5 In the Print dialog box choose Settings > 3D Plotting.

The 3D Plotting Options dialog box opens.

6 In the 3D Plotting Options dialog box set the following options:

Convert Animation: On

7 Click OK in the 3D Plotting Options dialog box.

8 In the Print dialog box, click the Print icon or select File > Print.
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The Save Print As dialog box opens.

9 Set the Directory in Save Print As dialog box to C:\ 

10 Click OK to save the PhotoRealistic Rendering-Loft-000.pdf file to your 
hard drive.

A progress bar appears at the bottom of MicroStation window indicating 
the percentage of completion. Once the PDF is finished you will see 
message Finished Creating Print at the bottom of screen.

Note: The 3D content in the Adobe PDF file will be displayed using smooth shading. 
For best results you may need to adjust your materials to look good using 
smooth shading routine. For instance a glass material that looks great ray 
traced may appear too transparent when smooth rendered.

Note: The design file used for this exercise has an associated Animator script and the 
animation will playback on startup from Adobe Acrobat Reader 9.

Interacting with 3D content in Adobe Reader

In order to open the PDF file generated in MicroStation it will be necessary to 
download and install Adobe Acrobat® 9.0 or later version, if available. Currently, 
you can download the software from http://www.adobe.com/products/acrobat/
readstep2.html.

Once a PDF document containing 3D content is created from MicroStation, it can 
be opened with Adobe® Reader® 9.0 in the same manner as a standard PDF file. 
Inside the pdf file, clicking on a 3D object will activate a toolbar with a set of tools 
for navigating within the scene. The standard Adobe Reader tools (Rotate, 
Navigate, Zoom, and Pan) are documented in the Adobe Reader Help. Saved 
Views are available from the Views menu entries.
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Left image shows manipulation options and right images shows saved view options

More Adobe options for viewing 3D Content

Left image is set to transparent and right image is using the Night Lights option
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Visualization Glossary

This glossary defines visualization terms used with MicroStation V8i.

actor 

In an animation sequence, an element(s) that are scripted to move or rotate in a 
controlled manner. Created as a cell.

adaptive subdivision

Process within radiosity solving that dynamically subdivides a surface element 
mesh along shadow boundaries, resulting in more accurate and detailed shading.

aliasing 

Source of several common computer graphics artifacts such as jagged lines, 
missing objects, and jerky motion in animation. In signal processing terms, 
aliasing is caused by the under-sampling of a signal, resulting in some high-
frequency components of the signal assuming the alias (or false identity) of the 
low frequency components, and mixing together in such a way that they can no 
longer be distinguished properly.

alpha channel/pixel

In graphics, a portion of each pixel's data that is reserved for transparency 
information. 32-bit graphics formats contain four channels -- three 8-bit channels 
for red, green, and blue (RGB) and one 8-bit alpha channel. The alpha channel is 
really a mask -- it specifies how the pixel's colors should be merged with another 
pixel when the two are overlaid, one on top of the other. 

Typically, you would not define the alpha channel on a pixel-by-pixel basis, but 
rather per object. Different parts of the object would have different levels of 
transparency depending on how much you wanted the background to show 
through. This allows you to create rectangular objects that appear as if they are 
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irregular in shape. You define the rectangular edges as transparent so that the 
background shows through. This is especially important for animation, where the 
background changes from one frame to the next. 

Rendering overlapping objects that include an alpha value is called alpha 
blending. 

With the Luxology dialog, it is possible to replace the alpha pixels in a rendered

image with either a solid color or image background. 

ambient light

Imaginary light that is presumed to strike every point on a surface with equal 
intensity. Used to approximate the large-scale effects of diffuse inter-reflections, a 
phenomenon not usually accounted for by most lighting methods. Ambient light 
should be turned off when using particle tracing or radiosity solving, both of 
which take into account the diffuse reflection of light between surfaces.

animation camera 

Actor that is scripted to designate a viewing position, orientation, and perspective 
for animation.

animation settings file

File (“.asf”) that contains design and rendering settings while recording an 
animation sequence. Particularly useful for collaborative recording of animation 
scripts on networked systems or continuing disrupted recordings.

anisotropy

Is the property of being directionally dependent, as opposed to isotropy, which 
means homogeneity in all directions. It can be defined as a difference in a physical 
property (absorbance, refractive index, density, etc.) for some material when 
measured along different axes.

antialiasing

Special rendering processing to remove or limit the appearance of aliasing 
artifacts in an image or an animation sequence. See also sample.
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area light source

Light source created from a shape element. This type of light source casts softer, 
more natural shadows than a Point light source.

camera 

Imaginary entity that specifies a scene's viewing position, orientation, and 
perspective. See also animation camera.

candela

The candela is the unit of luminous intensity; that is, power emitted by a light 
source in a particular direction. A common candle emits light with a luminous 
intensity of roughly one candela.

caustics 

Lighting effects caused by light reflected off surfaces, or refracted through 
transparent objects.

color bleeding

Shading effect observable in particle traced and radiosity solutions caused by 
diffuse-inter-reflections between surfaces. For example, a colored wall often 
reflects a small amount of its color onto an adjoining white wall.

diffuse interreflection

A global process of light transport among all the surfaces in an environment, 
based on a series of diffuse reflections between surfaces. 

diffuse reflection

Type of reflection that sends light in all directions with equal energy. Diffuse 
reflection is said to be “view independent.” See also specular reflection.

displacement maps

Displacement maps simulate the geometry used to create them in the first place, 
and display the displacement map geometry in place of the underlying element.
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dolly (camera) 

To move the view cone while keeping the camera and target points in the same 
positions relative to each other — that is, without changing its orientation.

dolly (light source)

To move a directional light source and its target point such that they remain in the 
same positions relative to each other — that is, without changing its orientation.

elevate 

To move the view cone, linearly, in a vertical direction.

environment cube 

Imaginary cube surrounding the entire design, on which images are applied as 
environment maps.

environment 

Image file representing the projection of a 3D environment onto a 2D surface 
from a specific point of view. A map set of these files can be applied to the six 
faces of the environment cube that surrounds a design (or environment). An 
environment map is not directly visible in the view, but is seen only when 
reflected or transmitted by surfaces in the model to which material characteristics 
are applied.

field rendering

Animation script recording technique that results in frames that consist of two 
fields each (one for the even numbered scan lines and one for the odd-numbered 
scan lines). Used to improve playback on NTSC and PAL video display systems that 
employ interlaced display.

focal point

The point at which initially collimated (parallel) rays of light meet after passing 
through a convex lens, or reflecting from a concave mirror.

frame 

Single rendered image that is part of a series of rendered images that make up an 
animation sequence.
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frame number

Identifies a frame's relative position in an animation sequence. Since the speed of 
an animation sequence (expressed in frames per second) is constant throughout 
the animation, frame numbers can also be thought of as points in time. Therefore, 
fractional frame numbers can be specified in script entries.

Fresnel effects

Effect of the angle of view on the reflectivity and transparency of a surface. For 
example, a window appears more reflective than transparent when viewed at a 
sharp angle.

frustum

Geometric shape used to describe the viewing volume in computer graphics, 
where the viewing plane sits at the top of a truncated pyramid that extends into 
the 3D environment.

global lighting

Shading of a surface that takes into account both direct lighting and some indirect 
lighting, such as reflections and refractions.

high dynamic range images

Luxology renders to a 64-bit High Dynamic Range (HDR) image and these images 
must be Tone Mapped to display on non-HDR monitors. We have implemented 
two different tone mapping options from which to choose. The options are 
Photographic tone mapping or a histogram-like tone mapping that works well 
when you have a limited color palette or monochromatic image. This wider 
dynamic range allows HDR images to more accurately represent the wide range of 
intensity levels found in real scenes ranging from direct sunlight to faint starlight.

highlight 

Brightly-lit area on a surface caused by a specular reflection.

illumination 

Specification of lighting on a surface.
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image point 

In photomatching, a known point on the photograph or rendered image that 
correlates to a monument point in the computer model.

image script

Text file (“.scr”) containing entries that define the names of design files, views, 
output filenames and formats, and rendering options for batch rendering.

interpolation 

Method by which an animation parameter smoothly varies from one state to 
another. Also refers to the blending of adjacent pixels of a texture map for 
smoother rendered images.

irradiance caching

The concept behind this technique is that by leveraging a smaller number of more 
accurate samples and blending between them, you can achieve an image of 
perceived quality in a shorter amount of time.

keyframe 

Frame in which the locations and orientations of particular elements are explicitly 
specified.

keyframing 

Most basic method of animation, in which keyframes are defined, and the system 
automatically computes the frames in between (a process known as “tweening”).

local lighting

Shading of the surface that accounts for direct lighting only — that is, lighting 
directly attributed to light sources.

local material 

Material definition for a model stored within the DGN file rather than externally in 
a palette (“.pal”) file.
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lumen

Units in which the brightness of light sources is expressed. Lumens are the 
photometric equivalent of watts, but only account for energy in the visible part of 
the electromagnetic spectrum. If a light source's Intensity setting is 1.0, its 
Lumens setting closely approximates lumens.

luminance versus illuminance

Illuminance is the amount of light coming from a light fixture that lands on a 
surface. It is measured in Lux. A typical office has an illuminance of between 300 
to 500 lux on desktops. 

Luminance describes the amount of light leaving a surface in a particular 
direction, and can be thought of as the measured brightness of a surface as seen 
by the eye. Luminance is expressed in Candelas per square foot, or more 
commonly, Candelas per square meter (Cd/m²). A typical computer monitor has a 
Luminance of about 100 Cd/m².

lux

The lux is the SI unit of illuminance and luminous emittance. It is used in 
photometry as a measure of the apparent intensity of light hitting or passing 
through a surface. One lux is equal to one lumen per square meter.

monument point 

In photomatching, a known point in the model whose corresponding image point 
is visible.

NTSC 

National Television Standards Committee. Video standard for television systems 
in the United States, Canada, and Japan.
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script

Animation script whose entries are listed in the Animation Producer settings box. 
The open script can be previewed and recorded.

PAL 

Phase Alternating Line. Dominant video standard for television systems in Europe 
and Australia.

pan 

To manipulate the view cone by revolving either the camera about the target 
(horizontally or vertically), or vice-versa.

parametric motion control

Animation method in which the position and orientation of elements are 
mathematically specified as a function of time.

photomatching 

Process of matching a model's viewing perspective to that of a photograph or 
rendered background image, which is attached to the model as a reference raster 
file. The expected result is a composite image in which the model is superimposed 
on the background image with correct positioning and orientation.

procedural bump map

Special type of bump map that dynamically calls a procedural texture function to 
compute a perturbed surface normal rather than performing a lookup into a 
stored image.

procedural pattern map

Special type of pattern map that dynamically calls a procedural texture function to 
compute pixel color rather than performing a lookup into a stored image.

procedural texture

Function that takes either a 2D texture coordinate or a 3D world coordinate as 
input, and returns a texture value (either a color for a pattern map or a normal for 
a bump map). The function can perform anything from a simple lookup into a 
standard texture map to a very complex calculation. When a solid to which a 3D 
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procedural texture is applied is rendered, the solid appears to be sculpted from 
the specified pattern rather than wrapped with the pattern.

roll 

Rotate the camera about the view Z-axis.

sample 

In antialiasing, the process of examining part of a pixel. Samples are combined 
into a final pixel value. The number of samples and the threshold at which 
sampling stops are adjustable settings.

script 

Text file (“.msa”) that contains animation script entries — directions concerning 
keyframes, views, parameter definitions, settings, actors, animation cameras, and 
targets.

specular reflection

Type of reflection that sends light primarily in a single outgoing direction related 
to a single incoming direction by the principles of geometric optics, resulting in 
either a mirror-like reflection or a glossy highlight. Specular reflection is said to be 
view-dependent.

terminator 

Line separating light and dark on curved surfaces, most noticeable when an object 
is illuminated by a single light source.

texture map 

Stored image used for texture mapping.

texture mapping

Process of applying detail to a surface without explicitly modeling it as part of the 
geometry of the surface. This process can be either a standard lookup into an 
image texture map or a function call to compute a value algorithmically. The 
resulting value can be used either as a pixel color value (as in a pattern map) or as 
a perturbed surface normal (as in a bump map).
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tweening 

In keyframing, the process in which the system automatically computes the 
frames in between keyframes.

uniform sampling 

Regular distribution of samples, equally spaced in all dimensions.

velocity 

Rate of change of an animation parameter as it varies from one state to another.

view cone 

Dynamically displayed indication of view extents that is used to set up the camera.

view-dependent lighting

Global lighting of a 3D environment that varies from image to image as the 
position of the view is changed, primarily because of specular reflections or 
refractions of visible surfaces.

view-independent lighting

Global lighting of a 3D environment that remains constant from image to image as 
the position of the view is changed, thereby allowing for reuse, which significantly 
shortens the rendering time of subsequent images.

viewing pyramid 

See view cone.
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Assessment
Assessment is often equated with evaluation, but the two concepts are different. 
Assessment is used to determine what an individual knows or can do. 

Complete the assessment to see what you have gained from reviewing this 
module or course (access to surveygizmo.com is necessary).

Note that assessments are for classroom or virtual classroom learning, and not for 
OnDemand learning.

Take Assessment
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